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CLUSTER UNIVERSITY : KURNOOL 
Composition of  Board of Studies in Computer Science  

for the Academic Years 2025–26 to 2027–28 

S. No. Name of the Faculty  Designation Name of the College 

1. Mr. P Raghavender Reddy Chairman 

Lecturer in Computer Science, 

Silver Jubilee Govt. College, Kurnool  

9441762630 

prr712@sjgckurnool.edu.in  

2. Smt. Girija Rani G 
Subject 

Expert 

Lecturer in Computer Science, 

KVR Govt. College for Women, 

Kurnool 

9494510260 

girija.gknl@gmail.com 

3 Smt. D Meenakshi 
Subject 

Expert 

Lecturer in Computer Science, 

Govt. Degree College for Men, 

Kurnool 

8639596405 

dmeenu1986@gmail.com 

4 Dr. G. V. Ramesh Babu 
University 

Nominee 

Associate Professor, 
Dept. of Computer Science, 

S. V. University, Tirupati – 517502 
9246999922 

gvrameshbabu2002@yahoo.com 

Functions: 

1. Preparation and approval of syllabi First Year BSc (CS) 1st & 2nd Semesters and First  

Year B.A/B.COM/B.Sc. 1st & 2nd Semesters (Artificial Intelligence as SEC) for the 

academic years 2025-26, 2026-27 & 2027-28 for Cluster University keeping in view 

the objectives of the university, interest of the stake holders and national requirement 

for consideration and approval of the Academic senate. 

2. Suggestions if any, regarding methodologies for innovative and evaluation techniques 

3. Suggestions if any, regarding research, teaching, extension and other academic 

activities in the Computer Science Department of Cluster university. 

4. Recommending panel of names to the Academic Council for appointment of Papers 

Setters and Examiners 

       
Chairperson                                                                                                         Registrar 

mailto:prr712@sjgckurnool.edu.in
mailto:girija.gknl@gmail.com
mailto:dmeenu1986@gmail.com
mailto:gvrameshbabu2002@yahoo.com


iii 

CLUSTER UNIVERSITY : KURNOOL 
MINUTES OF THE MEETING 

Minutes of the Meeting held on 29.11.2025 
 The Board of Studies in Computer Science met on 29.11.2025 discussed and 

finalized the syllabus for the  Cluster University, prepared based on Common Core 

Syllabus recommended by APSCHE, Mangalagiri and unanimously approved the 

following academic proposals to be implemented from the Academic Year 2025-26: 

1. Syllabi of 1st and 2nd Semesters of B.Sc. (Honours) Computer Science & 1st and 2nd 

Semesters of B.A/B.COM/B.Sc. (Honours) (Artificial Intelligence as Skill Enhancement 

Course) for the academic years 2025-26, 2026-27 & 2027-28 for the Cluster 

University keeping in view the objectives of the university, interest of the stake 

holders and national requirement for consideration and approval of the Academic 

senate.  

2. Panel for Papers Setters and Examiners. 

3. Question Pattern and Model Question Papers. 

S. No. Faculty Details  Designation Signature 

1. 

Mr. P Raghavender Reddy 
Lecturer in Computer Science, 

Silver Jubilee Govt. College, Kurnool 

9441762630 

prr712@sjgckurnool.edu.in 

Chairman 

 

2. 

Smt. Girija Rani G 
Lecturer in Computer Science, 

KVR Govt. College for Women, Kurnool 

9494510260 

girija.gknl@gmail.com 

Subject 

Expert  

3 

Smt. D Meenakshi 
Lecturer in Computer Science, 

Govt. Degree College for Men, Kurnool 

8639596405 

dmeenu1986@gmail.com 

Subject 

Expert 
 

4 

Dr. G. V. Ramesh Babu 
Associate Professor, 
Dept. of Computer Science, 
S. V. University, Tirupati– 517502 
9246999922 

gvrameshbabu2002@yahoo.com 

University 

Nominee 
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE 

 

(Syllabus with Outcome, Co-curricular Activities, References and Model Question Papers 

for 1st, 2nd, 3rd & 4th Papers in 1st and 2nd Semesters) 

 

Structure of COMPUTER SCIENCE Major Syllabus for  

First Year B.Sc. (Honours) Programme  

Year Semester Paper Code Title 
Hrs 
per 

week 
Credits 

Marks 

IA EA 

First 
Year 

I 

25CSC101M 
Computer Fundamentals 

and Office Automation 
3 3 30 70 

25CSC101MP 

Computer Fundamentals 

and Office Automation 

Practical 

2 1 -- 50 

25CSC102M Problem Solving in C 3 3 30 70 

25CSC102MP 
Problem Solving in C 

Practical 
2 1 -- 50 

II 

25CSC203M Data Structures using C 3 3 30 70 

25CSC203MP 
Data Structures using C 

Practical  
2 1 -- 50 

25CSC204M Digital Logic Design 3 3 30 70 

25CSC204MP 
Digital Logic Design 

Practical  
2 1 -- 50 

  Community Service Project (minimum of 80 hours with 1 Credit) 
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE 

 

(Syllabus with Outcome, Co-curricular Activities, References and Model Question Papers 

for 1st & 2nd Papers in 1st and 2nd Semesters) 

 

Structure of COMPUTER SCIENCE Major Syllabus for  

Skill Enhancement Course (SEC)  

for First Year B.A./B.Com./B.Sc. (Honours) Programme  

Year Semester Paper Code Title 
Hrs 
per 

week 
Credits 

Marks 

IA EA 

First 
Year 

I 

25SEC101 
Introduction to Artificial 

Intelligence  
4 4 30 70 

25SEC101P 
Introduction to Artificial 

Intelligence – practical  
2 0 0 0 

II 

25SEC201 
Applications of Artificial 

Intelligence 
4 4 30 70 

25SEC201P 
Applications of Artificial 

Intelligence – Practical  
2 0 0 0 

 
 

NOTE: Paper – II is divided into five disciplines, they are  
1. Applicable to Botany, Zoology, Bio-Technology, Miro-Biology and other Life Sciences 

2. Applicable to Commerce and Management 

3. Applicable to History, Economics, Political Science, Linguistics, and any other 

Humanities 

4. Applicable to Mathematics, Physics, Chemistry and any other Mathematical Sciences 

5. Applicable to Computer Science, Data Science, Artificial Intelligence, Cognitive 

Systems, Data Analytics, Cloud Computing, Cyber Security and any other Computer 

Science Allied Streams 



with effect from academic year 2025–2026  
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

Semester Paper Code Paper Title Hrs./Week Credits  

I 25CSC101M 
Computer Fundamentals and Office 

Automation 
3 3 

Course Objectives:  
1. Understand foundational computing concepts, including number systems, the 

evolution of computers, block diagrams, and generational progress. 

2. Develop knowledge of computer architecture, focusing on system organization and 

networking fundamentals. 

3. Acquire practical skills in document creation, formatting, and digital presentations 

using word processing tools. 

4. Gain proficiency in spreadsheet operations, such as data entry, formulas, functions, 

and charting techniques. 

5. Introduce data visualization and basic modelling principles, fostering analytical 

thinking in structuring and interpreting data sets. 

Course Learning Outcomes:  
 Upon successful completion of the course, a student will be able to:  

1. Explain different number systems, the historical evolution of computers, and identify 

key components in a block diagram. 

2. Demonstrate basic blocks of a computer and fundamental networking knowledge. 

3. Create professional-level documents and design visually appealing presentations 

using word processing software and presentation software. 

4. Manipulate data within spreadsheets, apply formulas, and generate accurate 

summaries and visualizations. 

5. Apply data modelling techniques to analyse, organize, and represent data effectively 

in various scenarios. 

UNIT – I: Number Systems, Evolution, Block Diagram and Generations   
Number Systems: Binary, Decimal, Octal, Hexadecimal; conversions between number 

systems. Evolution of Computers: History from early mechanical devices to modern-day 

systems. Block Diagram of a Computer: Components like Input Unit, Output Unit, Memory, 

CPU (ALU+CU). Generations of Computers: First to Fifth Generation – technologies, 

characteristics, examples. 

UNIT – II: Basic organization and N/W fundamentals  
Computer Organization: Functional components – Input/Output devices, Storage types, 

Memory hierarchy. Types of Computers: Micro, Mini, Mainframe, and Supercomputers. 

Networking Fundamentals: Definition, need for networks, types (LAN, WAN, MAN), 

topology (Star, Ring, Bus). Internet Basics: IP Address, Domain Name, Web Browser, 

Email, WWW. 

http://www/
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UNIT – III: Word Processing and presentations 

Word Processing Basics: Using MS Word/Google Docs – formatting, styles, tables, mail 

merge. Presentation Tools: Using PowerPoint/Google Slides – slide design, animations, 

transitions. Applications: Creating resumes, reports, brochures, and presentations. 

Keyboard Shortcuts.  

UNIT – IV: Spreadsheet Basics 
Spreadsheet Concepts: Understanding rows, columns, cells in tools like MS Excel/Google 

Sheets, cell referencing. Functions and Formulae: SUM, AVERAGE, IF, COUNT. Charts and 

Graphs: Creating visual representations. Data Handling: Sorting, filtering, conditional 

formatting. Text Functions: LEFT, RIGHT, MID, LEN, TRIM, CONCAT, TEXTJOIN. Advanced 

Functions: Logical: IF, AND, OR, IFERROR, Lookup: XLOOKUP. 

UNIT – V: Data Analysis and Visualization 
Conditional Formatting: Custom rules, Colour scales, Icon sets, Data bars. Data Analysis 

Tools: Pivot Tables and Pivot Charts, Data Validation (Dropdowns, Input Messages, Error 

Alerts), What-If Analysis: Goal Seek, Scenario Manager, Data Tables. Productivity Tips: 

Using Named Ranges, Freeze Panes, Split View. 

Textbooks: 
1. Fundamentals of Computers, Reema Thareja, Oxford University Press, 2nd Edition 

2. Fundamentals of Computers, V. Rajaraman – PHI Learning 

3. Introduction to Computers by Peter Norton – McGraw Hill 

4. Microsoft Office 365 In Practice by Randy Nordell – McGraw Hill Education 

References: 
1. Excel 2021 Bible by Michael Alexander, Richard Kusleika – Wiley 

2. Networking All-in-One For Dummies by Doug Lowe – Wiley 

3. Microsoft Official Docs and Training: https://learn.microsoft.com 

4. Google Workspace Learning Center: https://support.google.com/a/users/ 

Activities: 
1. Outcome: Explain different number systems, the historical evolution of computers, 

and identify key components in a block diagram. 

 Activity: Create a digital poster or infographic comparing number systems (binary, 

decimal, octal, hexadecimal) and illustrating the timeline of computer generations 

with key innovations. 

 Evaluation Method: Rubric-based assessment of the poster presentation on a 10-

point scale focusing on: 

• Accuracy of number system conversions 

• Correct identification of block diagram components 

• Visual organization and creativity 

2. Outcome: Learners will demonstrate basic blocks of a computer and fundamental 

networking knowledge. 

 Activity: Design a concept map showing the internal architecture of a computer and 
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types of networks (LAN, WAN, MAN), including devices and topologies. 

 Evaluation Method: Checklist-based peer review and instructor validation: 

• Completeness of the map 

• Correctness of networking concepts 

• Use of appropriate terminology 

• Logical flow and structure of the map 

3. Outcome: Learners will create professional-level documents and design visually 

appealing presentations using word processing software and presentation software. 

 Activity: Prepare a formal report (e.g., project proposal) in a word processor and 

present it using a slide deck with transitions, embedded media, and design elements. 

 Evaluation Method: Performance-based evaluation using a 10-point scoring scale: 

• Formatting and structure of the document 

• Presentation aesthetics and clarity 

• Communication skills during presentation 

4. Outcome: Learners will manipulate data within spreadsheets, apply formulas, and 

generate accurate summaries and visualizations. 

 Activity: Analyze a dataset (e.g., student scores or sales data) using spreadsheet 

software. Apply formulas (SUM, AVERAGE, IF, VLOOKUP) and create relevant charts. 

 Evaluation Method: Practical test with a rubric: 

• Correct use of formulas 

• Accuracy of data summaries 

5. Outcome: Learners will apply data modelling techniques to analyse, organize, and 

represent data effectively in various scenarios. 

 Activity: Prepare an interactive dashboard for a given data set using EXCEL. 

 Evaluation Method: Evaluation of the dashboard on a 10-point scoring scale: 

• Presentation aesthetics and clarity 

• Interactiveness 

• Communication skills during presentation 

*******@@@****** 
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

Semester Paper Code Paper Title Hrs./Week Credits  

I 25CSC101MP 
Computer Fundamentals and Office 

Automation Practical 
2 1 

List of Experiments: 
1. Demonstration of Assembling and Disassembling of Computer Systems. 

2. Identify and prepare notes on the type of Network topology of your institution. 

3. Prepare your resume in Word. 

4. Using Word, write a letter to your higher official seeking 10-days leave. 

5. Prepare a presentation that contains text, audio and video. 

6. Using a spreadsheet, prepare your class Timetable. 

7. Using a spreadsheet, prepare marksheet of your friends. 

8. Using a Spreadsheet, calculate the Gross and Net salary of employees(Min 5) 

considering all the allowances. 

9. Generate the class-wise and subject-wise results for a class of 20 students. Also 

generate the highest and lowest marks in each subject. 

10. Using IF, AND, OR, and IFERROR to Automate Grade Evaluation. 

a. Create a table of student scores in different subjects. 

b. Use IF to assign grades (A/B/C/Fail). 

c. Use IFERROR to handle missing scores or invalid data. 

11. Employee Database Search Using XLOOKUP 

a. Create a database of employees (Name, ID, Department, Salary). 

b. Implement XLOOKUP to search by employee ID. 

c. Use XLOOKUP to extract department heads by role. 

12. Sales Report Analysis Using Pivot Tables and Charts 

a. Use a dataset of product sales (Product, Region, Date, Quantity, Revenue). 

b. Create Pivot Tables to summarize data by region/product. 

c. Insert Pivot Charts for visual analysis (e.g., bar, line). 

d. Add slicers to make the dashboard interactive. 

13. Monthly Budget Planning using Goal Seek and Scenario Manager 

a. Create a simple personal budget (income, expenses, savings). 

b. Use Goal Seek to determine income needed to save a desired amount. 

c. Use Scenario Manager to compare different budgeting scenarios. 

d. Create a one-variable Data Table to analyse how different expenses affect savings. 

*******@@@******  
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

Semester Paper Code Paper Title Hrs./Week Credits  

I 25CSC102M Problem Solving Using C 3 3 

Course Objectives:  
1. Understand the fundamentals of computer programming, Apply structured problem- 

solving approaches using algorithms, flowcharts, and C programming constructs. 

2. Develop efficient logic using decision-making, loop, and jump control statements. 

3. Utilize derived data types like arrays and strings for modular program design. 

4. Design and implement modular solutions using functions, recursive logic, pointer 

operations, and dynamic memory management. 

5. Handle complex data structures including structures, unions, and text file operations. 

Course Learning Outcomes:  
 Upon successful completion of the course, a student will be able to:  

1. Understand basic computing concepts, programming paradigms and write structured 

C programs. 

2. Apply control flow statements to solve logical and repetitive tasks in C. 

3. Implement arrays and string operations to manage and manipulate data efficiently. 

4. Design modular code using functions, recursion, and appropriate parameter passing. 

5. Utilize pointers and memory operations for effective data handling. Demonstrate 

competence in dynamic memory allocation and text file processing. 

UNIT – I:  Introduction to Computer Programming 
Introduction, Types of software, Compiler and interpreter, Concepts of Machine level, 

Assembly level and high-level programming, Flowcharts and Algorithms, Fundamentals 

of C: History of C, Features of C, C Tokens-variables and keywords and identifiers, 

constants and Data types, Rules for constructing variable names, Operators, Structure of 

C program, Input /output statements in C- Formatted and Unformatted I/O. 

UNIT – II: Control Statements   
Decision making statements: if, if else, else if ladder, switch statements. Loop control 

statements: while loop, for loop and do-while loop. Jump Control statements: break, 

continue and goto. 

UNIT – III: Derived Data Types in C 

Arrays: One Dimensional arrays - Declaration, Initialization and Memory representation; 

Two Dimensional arrays -Declaration, Initialization and Memory representation. Strings: 

Declaring, Initializing string variables; String handling functions, Character handling 

functions.  
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UNIT – IV: Functions  
Pointers: pointer data type, pointer declaration, initialization, accessing values using 

pointers. pointers and arrays. 

Function: Prototype, definition and calling. return statement, nesting of functions. 

categories of functions. Recursion (Basic Concept only). Parameter Passing by address & 

by value. Local and Global variables. Storage classes: automatic, external, static, register. 

UNIT – V: Dynamic Memory Management, Structures, Unions, Files 
Introduction, Functions-malloc, calloc, realloc, free. Structures: Basics of structure, 

structure members, accessing structure members, nested structures, array of structures. 

Unions - Union definition; difference between structures and unions. Working with text 

files - modes: opening, reading, writing and closing text files. 

Textbooks: 
1. Programming in ANSI C, E. Balagurusamy, Tata McGraw Hill, 6th Edition. 

2. Computer fundamentals and programming in C, Reema Theraja, Oxford University 

Press  

References: 
1. Let us C, Y Kanetkar, BPB publications 

2. Head First C: A Brain-Friendly Guide, David Griffiths, Dawn Griffiths 

Activities: 
1. Outcome: Understand basic computing concepts, programming paradigms and write 

structured C programs. 

 Activity: Create a concept map of computing fundamentals and programming 

paradigms (procedural, structured, object-oriented). Then, they write a structured C 

program (e.g., a calculator or student grade system) using proper syntax, 

indentation, and modular design. 

 Evaluation Method: Rubric-based Code Review & Viva to check the 

• The correctness of the concept map 

• Correct use of structure (main + functions) 

• Identification of paradigm used 

• Code readability and documentation 

2. Outcome: Apply control flow statements to solve logical and repetitive tasks in C. 

 Activity: Implement a program that solves a logic puzzle (e.g., number guessing 

game, pattern generation, or prime number finder) using if, switch, for, while, and 

do-while. 

 Evaluation Method: Automated Test Cases + Peer Review to check the 

• Correct use of control statements 

• Logical correctness of output 

• Efficiency and edge case handling 

• Peer feedback on clarity and logic 

3. Outcome: Implement arrays and string operations to manage and manipulate data 
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efficiently. 

 Activity: Build a program that stores and arranges student marks in ascending and 

descending order using arrays and performs string operations like concatenation, 

comparing, and formatting names. 

 Evaluation Method: Functional Demonstration + Code Walkthrough to check the 

• Correct array and string usage 

• Memory efficiency 

• Handling of invalid inputs 

• Explanation of sorting/searching logic 

4. Outcome: Design modular code using functions, recursion, and appropriate 

parameter passing  

 Activity: Recursive Problem Solver – Students write a modular program to solve a 

recursive problem (e.g., factorial, Fibonacci, or Tower of Hanoi) using functions with 

parameters and return values. 

 Evaluation Method: 

• Code Trace + Written Quiz 

• Correct function decomposition 

• Proper parameter passing (by value/reference) 

• Recursion depth and base case handling 

• Quiz on tracing recursive calls 

5. Outcome:  Utilize pointers and memory operations for effective data handling. 

Demonstrate competence in dynamic memory allocation and text file processing. 

 Activity: Create a program that dynamically stores user input (e.g., survey 

responses) using pointers and writes/reads the data to/from a text file. 

 Evaluation Method: Memory Debugging + File I/O Assessment to check the 

• Proper use of malloc, calloc, realloc, and free 

• Pointer arithmetic and dereferencing 

• File creation, reading, writing, and error handling 

• Use of tools like Valgrind or manual memory trace (Optional for Unix flavours) 

*******@@@****** 
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

Semester Paper Code Paper Title Hrs./Week Credits  

I 25CSC102MP Problem Solving Using C Practical 2 1 

List of Experiments: 
1. Write a program to check whether the given number is Armstrong or not. 

2. Write a program to find the sum of individual digits of a positive integer. 

3. Write a program to generate the first n terms of the Fibonacci sequence. 

4. Write a program to find both the largest and smallest number in a list of integer values 

5. Write a program to demonstrate change in parameter values while swapping 

two integer variables using Call by Value & Call by Address 

6. Write a program to perform various string operations. 

7. Write a program to search an element in a given list of values. 

8. Write a program that uses functions to add two matrices. 

9. Write a program to calculate factorial of given integer value using recursive functions 

10. Write a program for multiplication of two N X N matrices. 

11. Write a program to sort a given list of integers in ascending order. 

12. Write a program to calculate the salaries of all employees using Employee 

(ID, Name, Designation, Basic Pay, DA, HRA, Gross Salary, Deduction, Net 

Salary) structure. 

a. DA is 30 % of Basic Pay 

b. HRA is 15% of Basic Pay 

c. Deduction is 10% of (Basic Pay + DA) 

d. Gross Salary = Basic Pay + DA+ HRA 

e. Net Salary = Gross Salary - Deduction 

13. Write a program to read / write the data from / to a file. 

14. Write a program to reverse the contents of a file and store in another file. 

15. Write a program to create Book (ISBN, Title, Author, Price, Pages, Publisher) 

structure and store book details in a file and perform the following operations 

a. Add book details 

b. Search a book detail for a given ISBN and display book details, if available 

c. Update a book detail using ISBN 

d. Delete book details for a given ISBN and display list of remaining Books 

*******@@@****** 
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

Semester Paper Code Paper Title Hrs./Week Credits  

I 25CSC202M Data Structures Using C 3 3 

Course Objectives:  
1. Understand fundamental concepts of algorithms and data structures with focus on 

complexity analysis and abstract data types. 

2. Explore various types of linked lists and their dynamic memory representations and 

operations. 

3. Analyze and implement linear data structures, such as stacks and queues, and 

examine their real-world applications. 

4. Apply sorting and searching algorithms, understanding their performance 

implications and optimization strategies. 

5. Design and manipulate hierarchical and graph-based structures, applying traversal 

algorithms and understanding their practical uses in computing. 

Course Learning Outcomes:  
 Upon successful completion of the course, a student will be able to:  

1. Explain algorithm characteristics, time and space complexity, and asymptotic 

notations with clarity. 

2. Implement and analyze different types of linked lists, including insertion, deletion, 

and traversal operations. 

3. Develop stack and queue data structures using arrays and linked lists and apply them 

in expression evaluation. 

4. Apply efficient searching and sorting algorithms to solve computational problems and 

evaluate performance trade-offs. 

5. Construct and traverse tree and graph structures. 

UNIT – I: Basic Concepts    
Algorithm: Definition and characteristics, Complexity analysis: Space Complexity, Time 

Complexity. 

Data Structures: Definition, Types of Data structures, Abstract Data Types (ADT). Array 

Operations. Linked Lists – Introduction, Representation of linked lists in Memory, 

Comparison between Linked List and Array. 

UNIT – II: Linked Lists   
Types of Linked Lists - Singly Linked list, Doubly Linked list, Circularly Singly Linked list, 

Circularly Doubly Linked list; Implementation of Single Linked List ADT: Creating a List, 

traversing a linked list, searching in linked list, Insertion and deletion into linked list (At 

first Node, Specified Position, Last node). 
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UNIT – III: Stacks and Queues 

Stack: Stack ADT, Implementation of stacks using array and Linked List, Application of 

stacks – Polish Notations, Converting Infix to Post Fix Notation, Evaluation of Post Fix 

Notation. 

Queues: Introduction to Queue ADT, Implementation of Queues using array and Linked 

List, Application of Queues, Types of Queues- Circular Queues, De-queues, Priority Queue, 

Heaps. 

UNIT – IV: Searching and Sorting  
Searching: Linear or Sequential Search, Binary Search, Hashing and collision resolution.  

Sorting: Selection Sort, Bubble Sort, Insertion Sort, Quick Sort and Merge Sort. 

UNIT – V: Trees and Graphs  
Tree: Terminology, Binary Tree Representation, Traversal Techniques, Expression Tree, 

Binary Search Tree – Definition, Operations on a Binary Search Tree: Creation, Search, 

Insertion & deletion. 

Graphs: Introduction to Graphs, Terminology, Representation (Adjacency Matrix, 

Adjacency List), Traversal of Graphs (DFS, BFS), Applications of Graphs. 

Textbooks: 
1. Data Structures Using C, Balagurusamy E. Tata MCGraw Hill 

2. Data Structures using C, Reema Thareja, Third Edition, Oxford University Press 

References: 
1. Data Structures, Lipschutz, Schaum’s Outline Series, Tata McGraw-Hill 

2. Data Structures Using C, Ch. Vijay Kumar, Pen Press International 

Activities: 
1. Outcome: Explain algorithm characteristics, time and space complexity, and 

asymptotic notations with clarity 

 Activity: Create a comparative chart of algorithms with different notations related to 

time and space complexities. 

 Evaluation Method: Rubric-based assessment of the chart for correctness, clarity, 

and depth of explanation on a 10-point scale. 

2. Outcome: Implement and analyze different types of linked lists, including insertion, 

deletion, and traversal operations 

 Activity: Code a menu-driven program in C to implement single linked lists with all 

basic operations. 

 Evaluation Method: Practical lab assessment with test cases and Viva-style 

questioning to explain pointer manipulation. 

3. Outcome: Develop stack and queue data structures using arrays and linked lists, and 

apply them in expression evaluation 

 Activity: Build a program to convert infix expressions to postfix and evaluate them 

using stacks; Implement queues using both arrays and linked lists with 

enqueue/dequeue operations. 
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 Evaluation Method: Code review and execution of programs for sample cases and 

evaluation based on correctness and efficiency. 

4. Outcome: Apply efficient searching and sorting algorithms to solve computational 

problems and evaluate performance trade-offs 

 Activity: Implement and compare sorting algorithms (e.g., selection sort and bubble 

sort) and searching algorithms (e.g., Linear vs. Binary Search) on datasets of varying 

sizes. Record number of swaps and iterations for preparing a chart to assimilate the 

results. 

 Evaluation Method: Performance report with graphs and analysis. Oral presentation 

or peer review discussing trade-offs and algorithm selection rationale. 

5. Outcome: Construct and traverse tree and graph structures 

 Activity: Implement binary trees and graphs using adjacency lists/matrices. 

 Evaluation Method: demo with sample inputs and visual output (tree traversal, 

graph traversal). 

*******@@@****** 
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

Semester Paper Code Paper Title Hrs./Week Credits  

II 25CSC203MP Data Structures Using C Practical 2 1 

List of Experiments: 
1. Write a program to read ‘N’ numbers of elements into an array and perform the 

following operation on an array 

a. Add an element at the beginning of an array 

b. Insert an element at given index of array 

c. Update an element using a value and index 

d. Delete an existing element 

2. Write a program to implement Single Linked List with insertion, deletion and traversal 

operations 

3. Write a program to implement the Stack operations using Arrays. 

4. Write a program to implement the Stack operations using Linked Lists. 

5. Write a program to convert a given infix expression to a postfix expression using 

stacks. 

6. Write a program to implement the Queue operations using Arrays. 

7. Write a program to implement the Queue operations using Linked Lists. 

8. Write a program for Binary Search Tree Traversals 

9. Write a program to search an item in a list using the Linear Search Algorithm. 

10. Write a program to search an item in a list using the Binary Search Algorithm. 

11. Write a program for implementation of the Bubble Sort Algorithm. 

12. Write a program for implementation of the Insertion Sort Algorithm. 

13. Write a program for implementation of the Selection Sort Algorithm. 

14. Write a program for implementation of the Quick Sort Algorithm. 

15. Write a program for implementation of the Merge Sort Algorithm. 

*******@@@****** 
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

Semester Paper Code Paper Title Hrs./Week Credits  

II 25CSC204M Digital Logic Design 3 3 

Course Objectives:  
1. Introduce the fundamentals of number systems, their conversions, and binary 

arithmetic operations. 

2. Explore digital logic through gates, Boolean algebra, and simplification techniques for 

logic functions. 

3. Develop proficiency in designing basic combinational circuits like adders and 

subtractors. 

4. Equip students with the skills to implement advanced combinational components 

such as multiplexers, encoders, and decoders. 

5. Foster understanding of sequential circuits, flip-flops, counters, and shift registers for 

system-level design. 

Course Learning Outcomes:  
 Upon successful completion of the course, a student will be able to:  

1. Apply concepts of number systems to perform radix conversions and binary 

arithmetic using signed and unsigned formats. 

2. Simplify logic functions using Boolean algebra, Karnaugh maps, and universal gates. 

3. Design and analyse combinational circuits such as half adders, full adders, and 

subtractors. 

4. Construct advanced combinational logic modules, including multiplexers, 

demultiplexers, encoders, decoders, and their hierarchical versions. Realize complex 

Boolean functions using combinations of logic modules. 

5. Develop and evaluate sequential circuits such as flip-flops, latches, counters, shift 

registers. 

UNIT – I:  Number Systems 
Conversion of numbers from one radix to another radix, r’s, (r–1)’s complements, signed 

binary numbers, addition and subtraction of unsigned and signed numbers, weighted and 

unweighted codes. 

UNIT – II: Logic Gates, Boolean Algebra    
NOT, AND, OR, universal gates, X-OR and X-NOR gates, Boolean laws and theorems, 

complement and dual of a logic function, canonical and standard forms, two level 

realization of logic functions using universal gates, minimizations of logic functions (POS 

and SOP) using Boolean theorems, K-map (up to four variables), don’t care conditions. 
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UNIT – III: Combinational Logic Circuits – 1  

Design of half adder, full adder, half subtractor, full subtractor, ripple adders and 

subtractors, ripple adder / subtractor.  

UNIT – IV: Combinational Logic Circuits – 2 
Design of decoders, encoders, priority encoder, multiplexers, demultiplexers, higher 

order decoders, demultiplexers and multiplexers, realization of Boolean functions using 

decoders, multiplexers. 

UNIT – V: Sequential Circuits  
Classification of sequential circuits, latch and flip-flop, RS- latch using NAND and NOR 

Gates, RS, JK, T and D flip-flops, truth tables and excitation tables, conversion of flip- flops, 

flip-flops with asynchronous inputs (preset and clear). Registers- shift registers, 

bidirectional shift registers, universal shift register. 

Textbooks: 
1. Digital Design, M. Morris Mano, Michael D Ciletti,5th edition, Pearson. 

2. Digital Logic Design, K.C. Rao, Ramana, Pen International Press 

References: 
1. Digital Electronics and Logic Design, Jaydeep Chakravorty, Universities Press 

2. Digital Logic Design, Sonali Singh, BPB Publications 

Activities: 
1. Outcome: Apply concepts of number systems to perform radix conversions and 

binary arithmetic using signed and unsigned formats 

 Activity: Design a calculator in a spreadsheet or simulation tool (e.g., Logisim) 

that performs: Decimal ↔ Binary ↔ Hexadecimal conversions and binary 

arithmetic (addition, subtraction). 

 Evaluation Method: Rubric-based evaluation on a 10point scale (conversion 

accuracy, arithmetic correctness) 

2. Outcome: Simplify logic functions using Boolean algebra, Karnaugh maps, and 

universal gates 

 Activity: Provide students with complex Boolean expressions and truth tables. 

Ask them to: Simplify using Boolean laws, Minimize using Karnaugh maps and 

Implement using only NAND or NOR gates 

 Evaluation Method: Worksheet submission with step-by-step simplification 

and evaluation of gate-level implementation using a 10-point scale. 

3. Outcome: Design and analyze combinational circuits such as half adders, full 

adders, and subtractors 

 Activity: Build and simulate: Half adder and full adder using logic gates, 

and half and full subtractor circuits 

 Evaluation Method: Evaluate the correctness of the circuits for different 

inputs on a 10-point scale. 

4. Outcome: Construct advanced combinational circuits, including 

https://in.bpbonline.com/collections/vendors?q=Sonali%20Singh
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multiplexers, demultiplexers, encoders and decoders. 

 Activity: Design Multiplexers for function selection, Decoders for control 

signal generation and Encoders for input compression 

 Evaluation Method: Project-based evaluation with functional demo and 

assessments based on a 10-point scale. 

5. Outcome: Develop and evaluate sequential circuits such as flip-flops, latches, 

counters, and shift registers 

 Activity: Implement and test SR, JK, D, T flip-flops, asynchronous and 

synchronous counters using a simulator (E.g. Logisim, Multisim) 

 Evaluation Method: Lab assessment on a 10-point scale to understand the 

correctness of the circuit and presentation of the design. 

*******@@@****** 
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

Semester Paper Code Paper Title Hrs./Week Credits  

II 25CSC204MP Digital Logic Design Practical 2 1 

List of Experiments: 
1. Verification of the truth tables of logic gates NOT, OR, AND using Circuitverse. 

2. Verification of the truth tables of logic gates NOR, NAND using Circuitverse. 

3. Verification of the truth tables of logic gates XOR, XNOR using Circuitverse. 

4. Implementation of the given Boolean functions using logic gates in SOP forms 

5. Implementation of the given Boolean functions using logic gates in POS forms 

6. Realization of basic gates using universal gate NAND. 

7. Realization of basic gates using universal gate NOR. 

8. Design and implementation of half and full adder circuits using logic gates. 

9. Design and implementation of half and full subtractor circuits using logic gates. 

10. Verification of stable tables of RS, JK, T and D flip-flops using NAND gates. 

11. Implementation and verification of Decoder and Encoder using logic gates. 

12. Implementation of 4X1 MUX and DMUX using logic gates. 

13. Implementation of 8X1 MUX using suitable lower order MUX. 

14. Implementation of 7-segment decoder circuit. 

15. Implementation of 4-bit parallel adder. 

 

Note: The laboratory work can be done by using physical gates and necessary equipment 

or simulators like https://sourceforge.net/projects/gatesim/ or 

https://circuitverse.org/ or any free open- source simulator 

 

*******@@@****** 
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https://circuitverse.org/
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

Semester Paper Code Paper Title Hrs./Week Credits  

I 25SEC101 Introduction to Artificial Intelligence  4 4 

Course Objectives:  
1. Understand the history and evolution of Artificial Intelligence and Identify major 

subfields of AI. 

2. Investigate the role of AI in various industries like healthcare, agriculture, and 

education. 

3. Examine concepts like bias, fairness, transparency, and accountability in AI systems. 

4. Explore the integration of AI in scientific research and discuss future directions and 

evolving trends in AI. 

5. Learn how prompt engineering is used in various sectors like education and content 

creation. 

Course Learning Outcomes:  
 Upon successful completion of the course, a student will be able to:  

1. Describe the different subfields and their roles in AI applications. 

2. Analyse the benefits and limitations of AI in diverse domains. 

3. Evaluate AI systems in terms of inclusivity, privacy, and robustness. 

4. Describe Generative AI and emerging technologies like ChatGPT. 

5. Apply prompt engineering concepts to various real-world use cases. 

UNIT – I: AI and AI Subfields   
Introduction to Artificial Intelligence, History, Definition, Artificial General Intelligence, 

Industry Applications of AI, Challenges in AI. Knowledge Engineering, Machine Learning, 

Computer Vision, Natural Language Processing, Robotics. 

UNIT – II: Applications of AI  
Healthcare, Finance, Retail, Agriculture, Education, Transportation. 

UNIT – III: Bias and Fairness in AI Systems 

Ethics in AI, Bias and Fairness in AI Systems, Transparency in AI Systems, Accountability, 

Security, Privacy, Inclusivity, Sustainability, Robustness, Reliability.  

UNIT – IV: AI in Research, Generative AI and prompt engineering 

AI in Experimentation and Multi-disciplinary research, Generative AI introduction, 

ChatGPT, Hugging Face, Gemini and other tools basics, Perplexity, Prompt engineering 

Definition and its importance, Role of Prompt Engineering in AI/ML Interaction, 

Emerging trends and Future Directions in AI. 

UNIT – V: Applications of Prompt Engineering 
Applications of Prompt Engineering: Education, Business & Commerce, Content Creation: 
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AI for Creative Writing, AI for creative design, writing AI scripts for video, generating 

slides and slidesGPT usage, Designing thumbnails and channel branding with AI. 

Textbooks: 
1. AI for Everyone: A Beginner's Handbook for Artificial Intelligence (AI) by Saptarsi 

Goswami, Amit Kumar Das , Amlan Chakrabarti 

2. Prompt Engineering for Beginners: by Kapila Arora, Geetu Garg, Gaurav Arora. 

References: 
1. Let’s Learn Artificial Intelligence: Base Module, Niti Ayog, Atal Innovation Mission. 

2. Prompt Engineering for Generative AI: Future-proof inputs for Reliable AI-outputs 

by James Phoenix & Mike Taylor. 

3. Generative AI Tutorial:https://www.w3schools.com/gen_ai/ 

4. Generative AI 360°: Practical Guide to ChatGPT, Midjourney & AI Tools to Boost 

Productivity & Creativity, For Professionals, Marketers & Entrepreneurs by Hitesh 

Motwani, ZebraLearn, 2025. 

5. Generative AI: Prompt Engineering Basics: 

6. Learn Generative AI Prompt Engineering for everyone 

https://www.coursera.org/learn/generative-ai-prompt-engineering-for-

everyone?action=enroll 

7. Free Artificial Intelligence (AI) Tutorial - Hands-On Prompt Engineering for AI 

Beginners & Business User | Udemy, https://www.udemy.com/course/prompt-

engineering-for-ai-beginners-business-users  

*******@@@****** 

https://www.amazon.in/Saptarsi-Goswami/e/B0D83SS3RZ/ref%3Ddp_byline_cont_book_1
https://www.amazon.in/Saptarsi-Goswami/e/B0D83SS3RZ/ref%3Ddp_byline_cont_book_1
https://www.amazon.in/s/ref%3Ddp_byline_sr_book_2?ie=UTF8&field-author=Amit%2BKumar%2BDas&search-alias=stripbooks
https://www.amazon.in/s/ref%3Ddp_byline_sr_book_3?ie=UTF8&field-author=Amlan%2BChakrabarti&search-alias=stripbooks
https://www.amazon.in/Kapila-Arora/e/B0DBG475LB/ref%3Ddp_byline_cont_book_1
https://www.amazon.in/Geetu-Garg/e/B0DKXJ7KQ7/ref%3Ddp_byline_cont_book_2
https://www.amazon.in/Gaurav-Aroraa/e/B07DCFG876/ref%3Ddp_byline_cont_book_3
https://www.w3schools.com/gen_ai/
https://www.coursera.org/learn/generative-ai-prompt-engineering-for-everyone?action=enroll
https://www.coursera.org/learn/generative-ai-prompt-engineering-for-everyone?action=enroll
http://www.udemy.com/course/prompt-engineering-for-ai-beginners-business-users
http://www.udemy.com/course/prompt-engineering-for-ai-beginners-business-users
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

Semester Paper Code Paper Title Hrs./Week Credits  

I 25SEC101P 
Introduction to Artificial 

Intelligence Practical 
2 0 

List of Experiments: 
1. Create a mind map of AI subfields: NLP, CV, ML, Robotics, Knowledge Engineering 

using Canva/Napkin AI/ Similar Open AI tool 

2. Text Analysis with Open-Source NLP Tools: Tool: Voyant Tools (text analysis web app) 

• Input sample texts (e.g., news articles, speeches). 

• Explore word frequency, keywords, sentiment. 

• Understand how NLP extracts meaning from text. 

3. Train a basic image classifier using webcam images. Observe how the model "learns." 

Using Google Teachable Machine 

• Train two image categories (“Smiling” vs. “Not Smiling”) using their own webcam 

images. 

• Observe how the model learns to classify. 

• Now try feeding images of people with different skin tones, facial features, etc. 

• Observe misclassifications or differences in confidence. 

4. Simulate an AI chatbot helping a farmer or a student. You may use any GenAI tool of 

your choice. You may use the prompt below and try your own. 

 Prompt: “Act as an agriculture assistant. A farmer wants to know the best crop based 

on soil and season. Ask questions and suggest crops.” 

5. Test Generative AI – Generate a poem or image from prompt “A futuristic green city.” 

using ChatGPT, Hugging Face (e.g., image or text generation) 

6. Observe how generative AI models may show biased results when prompted with 

neutral profession descriptions. (Bing Image Creator / DALL·E on ChatGPT/ChatGPT).  

 Generate images using the following neutral prompts: 

• “A doctor treating a patient” 

• “A teacher in a classroom” 

• “A CEO giving a speech” 

• “A software engineer working from home”  

 Observe and discuss: 

• What gender/race/age are most commonly shown? 

• Are the results stereotypical or diverse? 

7. Check how language models may express bias depending on names, ethnicity, or 

location. 

 Use ChatGPT or Gemini  

• Prompt A: “A person named Raj is applying for a bank loan. Will he be approved?” 

• Prompt B: “A person named John is applying for a bank loan. Will he be approved?”  
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 Change names, genders, and nationalities. 

 Observe the following and report your findings: 

• Are the responses different? 

• Is one version more positive or negative? 

• Does the model express bias or hesitate? 

• Should AI make such predictions? 

• How do developers prevent this? 

8. Exploring Text Generation and Summarization with Google AI Studio 

 Generate Creative Content 

“Write a short story (150 words) about a robot who wants to become a chef.” 

▪ Submit and read the AI-generated story. 
▪ Discuss how detailed and creative the output is. 

 Summarize a Paragraph  

Prompt: Summarize the following paragraph in 3 sentences: 

“Artificial Intelligence is a branch of computer science that aims to create intelligent 

machines that can mimic human thinking. It includes various subfields like machine 

learning, natural language processing, and robotics. AI is widely used in industries 

such as healthcare, finance, and transportation to improve efficiency and decision-

making.” 

• Submit and review the summary. 

• Evaluate how well AI extracts key points. 

 Refine Your Prompt 

Try changing the summary prompt to:  

“Summarize the paragraph above in simple language for 10-year-olds.” 

• Compare this output to the previous one. 

• Note how prompt wording changes results. 

9. AI for Creative Writing 

 Prompt: “Write a short motivational story for 10-year-old students in under 150 

words.” 

10. Generate Slides: Tool: SlidesGPT/Other Free AI tool 

 Prompt: “Create a 5-slide presentation on ‘AI in Smart Farming.’” 

11.  YouTube Thumbnails / Branding: Tool: Canva + Magic Media AI  
 Design a thumbnail using Canva’s AI tools with a prompt like: 

• “Design a YouTube thumbnail for a video titled ‘Top 5 AI Tools for Students’” 

*******@@@******  
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

1. APPLICABLE TO BOTANY, ZOOLOGY, BIO-TECHNOLOGY, MIRO- BIOLOGY AND OTHER 

LIFE SCIENCES 

Semester Paper Code Paper Title Hrs./Week Credits  

II 25SEC201 Applications of Artificial Intelligence 4 4 

Course Objectives:  
1. Provide a foundation in the AI ecosystem, including hardware, cloud, and edge 

platforms relevant to biological sciences. 

2. Familiarize students with different types of datasets and public repositories used in 

AI research. 

3. Develop skills in building AI data pipelines through collection, annotation, cleaning, 

and preprocessing. 

4. Explore real-world applications of AI in agriculture, ecology, zoology, and 

environmental sciences. 

5. Introduce AI-driven approaches in biotechnology and chemistry, such as genome 

sequencing, protein structure prediction, and drug discovery. 

Course Learning Outcomes:  
 Upon successful completion of the course, a student will be able to:  

1. Explain the role of AI hardware, edge devices, and cloud platforms in enabling 

applications in biological sciences. 

2. Differentiate data types and utilize public datasets relevant to AI in life sciences. 

3. Design and implement a conceptual AI data pipeline for solving biological problems. 

4. Apply AI techniques in case studies of agriculture, zoology, ecology, and 

environmental monitoring. 

5. Analyse the impact of AI in biotechnology and chemistry, particularly in genome 

sequencing, protein prediction, and drug discovery. 

UNIT – I:  Infrastructure and Platforms for Building Applications using AI 
Hardware used in building AI applications: Processors - CPU, GPU, TPU, NPU, Memory - 

RAM, VRAM, Storage - HDD, SSD. Platforms for building applications using AI: Online 

platforms (Example - Google AutoML, H2O.ai, Teachable Machine or similar platforms - 

for practice only); Desktop (No-code/Low- code) platforms (Orange Data Mining, KNIME, 

Weka, RapidMiner or similar tools - for practice only). Edge AI: Concept; Applications in 

daily life in devices like Refrigerators, Led Bulbs, Surveillance Cameras, Micro Ovens, 

Smart Cars/Scooters; Edge AI in smart Appliances. 

UNIT – II: Foundations of Datatypes, Ethics & Utility in Building Applications using AI   

Importance of data in building AI applications: Data as the fuel for AI, Role of big data in 

training AI models. Conceptual Foundations of Data: Data vs. Information vs. Knowledge. 

Structure of Data: Structured, Semi-Structured, and Unstructured Data.  
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Modalities of Data: Text, Image, Audio, Video, Tabular, Time-Series, and Spatial Data.  

Formats of Data: Text Formats (CSV, JSON, XML), Image Formats (JPEG, GIF, PNG), 

Audio/Video (MP3, WAV, MP4, AVI). 

Data Repositories: Definition of public Datasets; Definition of private Datasets; 

Importance of Public Datasets, Popular Public Dataset Repositories (Example - Kaggle, 

Hugging Face Datasets, UCI Machine Learning Repository, Google Dataset Search or 

similar ones - for demonstration only), Dataset licensing and usage rights. 

Ethics, Privacy in Data Usage: Privacy concerns related to data usage; Regulations 

governing data usage - GDPR, HIPAA (Overview), Ethical use of data, Responsible AI data 

practices. 

UNIT – III: The AI Data Pipeline: From Collection to Model Readiness 

The AI Data Pipeline: Stages and Components: Key Stages (Data Collection, Annotation, 

Preprocessing, Splitting, Feeding into AI Models. Core Components: Ingestion, Storage, 

Processing, Validation, Delivery. Data Collection Methods for AI: Manual Input (Surveys, 

forms, human-curated entries), Sensors & IoT Devices (Real-time data from physical 

environments), System Logs & Transactions, Web Scraping (Automated extraction from 

websites), APIs (Structured data access from external platforms). 

Data Annotation and Labelling: Definition & Importance; Annotation Methods: Manual 

Annotation, Automated Annotation; Types of Annotation: Classification, Bounding Boxes, 

Segmentation, Transcription, Named Entity Recognition (NER). 

Data Cleaning and Preprocessing: Importance of data cleaning; Understanding “Dirty” 

Data: Missing Values, Duplicates, Incorrect Formats, Outliers, Noise; Steps in Data 

Cleaning: Identify Issues, Handle Errors (Imputation, Removal), Validate Cleaned Data. 

Data Splitting: Splitting data into training set and test set. Data Transformation 

Techniques: Normalization, Transformation, Feature Engineering (Conceptual).  

UNIT – IV: AI in Biological Sciences 
AI in Botany & Agriculture: Plant disease detection via image recognition; Crop yield 

forecasting using climate and soil analytics; Precision agriculture: smart irrigation and 

fertilizer planning. 

AI in Zoology, Ecology & Environmental Sciences: Wildlife monitoring: species ID from 

camera trap data; Aquatic systems: fish recognition and water quality modelling; 

Livestock health and disease prediction; Environmental tracking: forest cover and 

pollution analysis. 

UNIT – V: AI in Biotechnology and Biochemistry 

Application of AI in Genome sequencing & gene function prediction; Using AI in Protein 

structure modeling (e.g., AlphaFold); AI for Drug discovery: virtual compound screening; 

Application of AI in Microbial classification & metagenomic profiling; Chemical reaction 

and material property prediction. 

Textbooks: 
1. Data Science for Beginners, Andrew Park 

(Introductory concepts of data types, collection, cleaning, and visualization without coding) 
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2. AI Basics for Non-Programmers, Tom Taulli 

(Clear explanations of AI data lifecycle and real-world use cases) 

3. Data Preparation for Machine Learning, Jason Brownlee 

(Conceptual understanding of dataset quality, preprocessing, and pipelines) 

4. Hands-On Data Science for Non-Programmers, David Meerman Scott 

(Spreadsheet-based data exploration and visualization) 

5. You Look Like a Thing and I Love You – Janelle Shane 

6. Artificial Intelligence in Life Sciences – Elsevier. 

7. Artificial Intelligence in Agriculture – CRC Press (B. Prasad). 

8. AI for Ecology and Conservation – Springer. 

9. Bioinformatics and Drug Discovery using AI – Academic Press. 

10. Databases & Platforms: FAO, GBIF, PlantVillage, ChEMBL, UniProt, AlphaFold DB 

References: 
1. Kaggle Dataset Search, https://www.kaggle.com/datasets  

2. Google Dataset Search, https://datasetsearch.research.google.com 

3. UCI Machine Learning Repository, https://archive.ics.uci.edu 

4. Hugging Face Datasets, https://huggingface.co/datasets 

5. Open Government Data (India), https://data.gov.in 

*******@@@****** 
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

1. APPLICABLE TO BOTANY, ZOOLOGY, BIO-TECHNOLOGY, MIRO- BIOLOGY AND OTHER 

LIFE SCIENCES 

Semester Paper Code Paper Title Hrs./Week Credits  

II 25SEC201 
Applications of Artificial 

Intelligence Practical 
2 0 

Suggested Lab Practical (No Coding): 
1. Lab 1 - Exploring Public Datasets (Orange Data Mining) 

• Visit a public repository (Kaggle, UCI, data.gov.in) 

• Download a dataset (e.g., rainfall data, literacy rates, or traffic accident statistics) 

• Procedure: 

1. Open Orange → Add File widget → Load a CSV (e.g., Titanic dataset). 

2. Connect to Data Table → View rows/columns. 

3. Connect to Data Info → Check attributes, data types. 

4. View in Data Table and Distributions widget. 

• Observation: Note numeric, categorical, missing values. 

• Outcome: Students understand structured data format in CSV. 

2. Lab 2 - Understanding Dataset Metadata and Formats 

• Take two datasets in different formats (CSV, JSON) 

• View metadata (description, features, size, license) 

• Compare domain-specific datasets (e.g., medical vs. finance) 

3. Lab 3 - Data Annotation Exercise 

• Use MakeSense.ai or VGG Image Annotator (VIA) 

• Annotate 10 sample images (traffic signs, fruits, or medical scans) 

• Export annotations in XML or YOLO format 

• Discuss annotation errors and challenges 

4. Lab 4 - Data Cleaning and Visualization (Orange Data Mining) 

• Aim: To clean dirty data and visualize categorical and numeric attributes. 

• Procedure: 

1. Load dataset. 

2. Connect File → Edit Domain (to change types) and Impute (to fill missing 

values). 

3. Compare cleaned vs. original in Data Table. 

4. Distributions widget. 

5. Check various features distribution. 

(Optional: Create simple bar charts/line charts to visualize trends using Google 

Looker Studio) 

• Observation: Missing values filled with mean/median., Graphical representation 

of data. 
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• Outcome: Learn importance of data cleaning., Students learn importance of 

visualization in preprocessing. 

5. Lab 5: Train/Test Split in Orange 

• Aim: To split a dataset for AI training/testing. 

• Procedure: 

1. Load Titanic dataset. 

2. Connect File → Data Sampler (70% train, 30% test). 

3. Connect outputs to Data Table widgets to view. 

• Observation: Students see two different subsets. 

• Outcome: Concept of model validation using split data. 

6. Lab 6: Plant Leaf Disease Detection 

• Dataset: Plant leaf disease datasets (PlantVillage, Kaggle). 

• Tool: Google Teachable Machine / Plantix app. 

• Activity: Upload leaf images to classify healthy vs diseased leaves. 

7. Lab 7: Crop Yield Prediction 

• Dataset: FAO crop yield datasets. 

• Tool: Orange Data Mining (drag-and-drop AI workflows). 

• Activity: Predict yield for different crops based on soil & climate features 

8. Lab 8: Species Recognization 

• Dataset: Camera trap image datasets (Snapshot Serengeti, LILA BC). 

• Tool: iNaturalist / Wildbook AI platform. 

• Activity: Upload wildlife images for species recognition & conservation mapping. 

9. Lab 9: Predict and visualize 3D protein structures: 

• Dataset: Genomic & protein sequence databases (NCBI, UniProt, AlphaFold DB). 

• Tool: AlphaFold Protein Structure Viewer (online). 

• Activity: Predict and visualize 3D protein structures. 

10. Lab 10: Analyze chemical similarity and predict drug-likeness. 

• Dataset: Drug compound datasets (ChEMBL). 

• Tool: ChemMine Tools (web-based). 

• Activity: Analyze chemical similarity and predict drug-likeness. 

11. Lab 11: Identify microbial species from sequencing datasets. 

• Dataset: Metagenomics datasets (MG-RAST). 

• Tool: MG-RAST online platform. 

• Activity: Identify microbial species from sequencing datasets. 

 

Note: The Tools suggested above are tentative. Teacher/Student is free to choose any 

other similar tool to execute the said lab experiments. 

*******@@@****** 
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

2. APPLICABLE TO COMMERCE AND MANAGEMENT 

Semester Paper Code Paper Title Hrs./Week Credits  

II 25SEC201 Applications of Artificial Intelligence 4 4 

Course Objectives:  
1. Provide a foundation in the AI ecosystem, including hardware, cloud, and edge 

platforms relevant to commerce and management. 

2. Familiarize students with different types of datasets and public repositories used in 

AI research. 

3. Develop skills in building AI data pipelines through collection, annotation, cleaning, 

and preprocessing. 

4. Understand how AI enhances retail and e-commerce and explore personalization, 

recommendation systems, and customer engagement 

5. Apply AI to streamline business processes and decision-making and explore AI in 

finance, HR, and supply chain management 

Course Learning Outcomes:  
 Upon successful completion of the course, a student will be able to:  

1. Explain the AI ecosystem (hardware, cloud, and edge devices) and its relevance to 

commerce and management. 

2. Differentiate between structured and unstructured data and utilize public datasets for 

business-oriented AI applications. 

3. Design a conceptual AI data pipeline for solving real-world problems in commerce and 

management. 

4. Understand and apply AI technologies to improve customer engagement and 

personalization in commerce. 

5. Use AI tools to streamline business operations, enhance decision-making, and detect 

patterns in data. 

UNIT – I:  Infrastructure and Platforms for Building Applications using AI 
Hardware used in building AI applications: Processors - CPU, GPU, TPU, NPU, Memory - 

RAM, VRAM, Storage - HDD, SSD. Platforms for building applications using AI: Online 

platforms (Example - Google AutoML, H2O.ai, Teachable Machine or similar platforms - 

for practice only); Desktop (No-code/Low- code) platforms (Orange Data Mining, KNIME, 

Weka, RapidMiner or similar tools - for practice only). Edge AI: Concept; Applications in 

daily life in devices like Refrigerators, Led Bulbs, Surveillance Cameras, Micro Ovens, 

Smart Cars/Scooters; Edge AI in smart Appliances. 
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UNIT – II: Foundations of Datatypes, Ethics & Utility in Building Applications using AI   

Importance of data in building AI applications: Data as the fuel for AI, Role of big data in 

training AI models. Conceptual Foundations of Data: Data vs. Information vs. Knowledge. 

Structure of Data: Structured, Semi-Structured, and Unstructured Data.  

Modalities of Data: Text, Image, Audio, Video, Tabular, Time-Series, and Spatial Data.  

Formats of Data: Text Formats (CSV, JSON, XML), Image Formats (JPEG, GIF, PNG), 

Audio/Video (MP3, WAV, MP4, AVI). 

Data Repositories: Definition of public Datasets; Definition of private Datasets; 

Importance of Public Datasets, Popular Public Dataset Repositories (Example - Kaggle, 

Hugging Face Datasets, UCI Machine Learning Repository, Google Dataset Search or 

similar ones - for demonstration only), Dataset licensing and usage rights. 

Ethics, Privacy in Data Usage: Privacy concerns related to data usage; Regulations 

governing data usage - GDPR, HIPAA (Overview), Ethical use of data, Responsible AI data 

practices. 

UNIT – III: The AI Data Pipeline: From Collection to Model Readiness 

The AI Data Pipeline: Stages and Components: Key Stages (Data Collection, Annotation, 

Preprocessing, Splitting, Feeding into AI Models. Core Components: Ingestion, Storage, 

Processing, Validation, Delivery. Data Collection Methods for AI: Manual Input (Surveys, 

forms, human-curated entries), Sensors & IoT Devices (Real-time data from physical 

environments), System Logs & Transactions, Web Scraping (Automated extraction from 

websites), APIs (Structured data access from external platforms). 

Data Annotation and Labelling: Definition & Importance; Annotation Methods: Manual 

Annotation, Automated Annotation; Types of Annotation: Classification, Bounding Boxes, 

Segmentation, Transcription, Named Entity Recognition (NER). 

Data Cleaning and Preprocessing: Importance of data cleaning; Understanding “Dirty” 

Data: Missing Values, Duplicates, Incorrect Formats, Outliers, Noise; Steps in Data 

Cleaning: Identify Issues, Handle Errors (Imputation, Removal), Validate Cleaned Data. 

Data Splitting: Splitting data into training set and test set. Data Transformation 

Techniques: Normalization, Transformation, Feature Engineering (Conceptual).  

UNIT – IV: AI in Commerce – Transforming the Consumer Experience 

Introduction to AI in Commerce, Recommendation Engines (Collaborative & Content-

Based), Chatbots and Virtual Assistants, Sentiment Analysis and Review Mining, 

Inventory Optimization and Demand Forecasting, Ethical Issues related to use of AI in 

Commerce and Business: Bias, Privacy, and Transparency. 

UNIT – V: AI in Business Operations – Driving Efficiency and Insight 

AI in Business Intelligence and Predictive Analytics, Financial Applications: Fraud 

Detection, Risk Modelling, HR Applications: Resume Screening, Employee Analytics, 

Supply Chain Automation and Optimization, AI in Marketing: Customer Segmentation, 

Lead Scoring, Strategic Adoption of AI in Enterprises, Explainable AI in E-Commerce. 

Textbooks: 
1. Data Science for Beginners, Andrew Park 
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(Introductory concepts of data types, collection, cleaning, and visualization without coding) 

2. AI Basics for Non-Programmers, Tom Taulli 

(Clear explanations of AI data lifecycle and real-world use cases) 

3. Data Preparation for Machine Learning, Jason Brownlee 

(Conceptual understanding of dataset quality, preprocessing, and pipelines) 

4. Hands-On Data Science for Non-Programmers, David Meerman Scott 

(Spreadsheet-based data exploration and visualization) 

5. You Look Like a Thing and I Love You – Janelle Shane 

References: 
1. Kaggle Dataset Search, https://www.kaggle.com/datasets  

2. Google Dataset Search, https://datasetsearch.research.google.com 

3. UCI Machine Learning Repository, https://archive.ics.uci.edu 

4. Hugging Face Datasets, https://huggingface.co/datasets 

5. Open Government Data (India), https://data.gov.in 

*******@@@****** 

http://www.kaggle.com/datasets
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

2. APPLICABLE TO COMMERCE AND MANAGEMENT 

Semester Paper Code Paper Title Hrs./Week Credits  

II 25SEC201 
Applications of Artificial 

Intelligence Practical 
2 0 

Suggested Lab Practical (No Coding): 
1. Lab 1 - Exploring Public Datasets (Orange Data Mining) 

• Visit a public repository (Kaggle, UCI, data.gov.in) 

• Download a dataset (e.g., rainfall data, literacy rates, or traffic accident statistics) 

• Procedure: 

1. Open Orange → Add File widget → Load a CSV (e.g., Titanic dataset). 

2. Connect to Data Table → View rows/columns. 

3. Connect to Data Info → Check attributes, data types. 

4. View in Data Table and Distributions widget. 

• Observation: Note numeric, categorical, missing values. 

• Outcome: Students understand structured data format in CSV. 

2. Lab 2 - Understanding Dataset Metadata and Formats 

• Take two datasets in different formats (CSV, JSON) 

• View metadata (description, features, size, license) 

• Compare domain-specific datasets (e.g., medical vs. finance) 

3. Lab 3 - Data Annotation Exercise 

• Use MakeSense.ai or VGG Image Annotator (VIA) 

• Annotate 10 sample images (traffic signs, fruits, or medical scans) 

• Export annotations in XML or YOLO format 

• Discuss annotation errors and challenges 

4. Lab 4 - Data Cleaning and Visualization (Orange Data Mining) 

• Aim: To clean dirty data and visualize categorical and numeric attributes. 

• Procedure: 

1. Load dataset. 

2. Connect File → Edit Domain (to change types) and Impute (to fill missing 

values). 

3. Compare cleaned vs. original in Data Table. 

4. Distributions widget. 

5. Check various features distribution. 

(Optional: Create simple bar charts/line charts to visualize trends using Google Looker Studio) 

• Observation: Missing values filled with mean/median., Graphical representation 

of data. 

• Outcome: Learn importance of data cleaning., Students learn importance of 

visualization in preprocessing. 
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5. Lab 5: Train/Test Split in Orange 

• Aim: To split a dataset for AI training/testing. 

• Procedure: 

1. Load Titanic dataset. 

2. Connect File → Data Sampler (70% train, 30% test). 

3. Connect outputs to Data Table widgets to view. 

• Observation: Students see two different subsets. 

• Outcome: Concept of model validation using split data. 

6. Lab 6: Introduction to AI in Commerce – Use Case Exploration  

• Prerequisite: Discuss conceptually about Clustering 

• Objective: Understand how AI is applied in commerce through data visualization 

and clustering. 

• Orange Workflow: Use Orange Data Mining Tool 

• Widgets Used: File → Data Table → Scatter Plot → Hierarchical Clustering 

• Dataset: Retail customer data (e.g., purchase frequency, amount spent) 

• Dataset Link: Retail Sales Data 

• Activities: 

1. Load customer data and visualize spending patterns. 

2. Apply clustering to identify customer segments. 

3. Discuss how businesses can tailor services to each segment. 

• Outcome: Students grasp how AI helps businesses understand and target 

consumers more effectively. 

7. Lab 7: Recommendation Engine Simulation Prerequisite: Discuss conceptually about 

Clustering 

• Objective: Simulate collaborative filtering using similarity-based clustering. 

• Orange Workflow: 

1. Widgets Used: File → Distance → Hierarchical Clustering → Data Table 

2. Dataset: User-product ratings matrix 

3. Dataset Link: Amazon Product Recommendation System 

• Activities: 

1. Calculate similarity between users. 

2. Group similar users and recommend products based on cluster behaviour. 

3. Discuss differences between collaborative and content-based filtering. 

• Outcome: Students understand the logic behind recommendation systems and 

how they personalize user experience. 

8. Lab 8: Chatbot Intent Classification 

• Prerequisite: Discuss conceptually about Linear Regression & Logistic Regression 

• Objective: Train a model to classify customer queries into intents. 

• Orange Workflow: 

1. Widgets Used: File → Preprocess Text → Bag of Words → Logistic Regression → 

Test & Score 

2. Dataset: Sample customer queries labeled with intents (e.g., “track order”, 

https://www.kaggle.com/datasets/noir1112/retail-sales-data
https://www.kaggle.com/datasets/noir1112/retail-sales-data
https://www.kaggle.com/code/rushiekarteekchalla/amazon-product-recommendation-system


with effect from academic year 2025–2026  

31 

“return item”) 

3. Dataset Link: Customer Intent Classification 

• Activities: 

1. Preprocess and vectorize text data. 

2. Train a classifier to predict query intent 

3. Evaluate accuracy and discuss chatbot training. 

• Outcome: Students learn how AI understands and responds to customer queries. 

9. Lab 9: Sentiment Analysis of Reviews 

• Prerequisite: Discuss conceptually about Naive Bayes Objective: Classify customer 

reviews as positive or negative.  

• Orange Workflow: 

1. Widgets Used: File → Preprocess Text → Bag of Words → Naive Bayes → Test & 

Score 

2. Dataset: Product reviews with sentiment labels 

3. Dataset Link: Amazon Product Reviews – Sentiment Analysis 

• Activities: 

1. Clean and tokenize review text. 

2. Train a sentiment classifier. 

3. Visualize word clouds for positive vs. negative reviews. 

• Outcome: Students analyze customer feedback and extract actionable insights. 

10. Lab 10: Demand Forecasting with Regression 

• Prerequisite: Discuss conceptually about Linear Regression & Logistic Regression 

• Objective: Predict future sales using regression models. 

• Orange Workflow: 

1. Widgets Used: File → Linear Regression → Scatter Plot → Test & Score 

2. Dataset: Historical sales data (e.g., monthly sales, promotions) 

3. Dataset Link: Comprehensive Retail Sales Data 

• Activities: 

1. Train a regression model to forecast sales. 

2. Visualize predictions vs. actuals. 

3. Discuss implications for inventory planning. 

• Outcome: Students understand how AI supports demand forecasting and 

inventory control 

11. Lab 11: Bias Detection in AI Models 

• Prerequisite: Discuss conceptually about Linear Regression, Logistic Regression & 

Confusion Matrix 

• Objective: Explore bias in predictive models and its impact. 

• Orange Workflow: 

1. Widgets Used: File → Logistic Regression → Confusion Matrix → Distributions 

2. Dataset: HR hiring data with gender or age attributes 

3. Dataset Link: HR Data Analytics 

• Activities: 

https://www.kaggle.com/code/youssefm0stafa/customer-intent-classifacation
https://www.kaggle.com/datasets/miriamodeyianypeter/sentiment-analysis-amazon-product-reviews
https://www.kaggle.com/datasets/shelendata/comprehensive-dataset-for-retail-data-analysis
https://www.kaggle.com/datasets/samruddhi4040/hr-data-analytics
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1. Train a model to predict hiring decisions. 

2. Analyze performance across demographic groups. 

3. Discuss fairness, transparency, and ethical implications. 

• Outcome: Students critically assess bias and propose ethical safeguards. 

12. Lab 12: Predictive Analytics for Business Intelligence  

• Prerequisite: Discuss conceptually about Random Forest Objective: Use 

classification to predict customer churn.  

• Orange Workflow: 

1. Widgets Used: File → Random Forest → Test & Score → ROC Analysis 

2. Dataset: Telecom or subscription data with churn labels 

3. Dataset Link: Telco Customer Churn – IBM Dataset 

• Activities: 

1. Train and evaluate a churn prediction model. 

2. Interpret ROC curves and accuracy. 

3. Discuss how businesses can act on predictions. 

• Outcome: Students apply predictive analytics to improve customer retention. 

13. Lab 13: AI in HR and Marketing – Resume Screening & Segmentation  

• Prerequisite: Discuss conceptually about Clustering 

• Objective: Classify resumes and segment customers using clustering. 

• Orange Workflow: 

1. HR Task: File → Preprocess Text → Bag of Words → Logistic Regression 

2. Marketing Task: File → k-Means Clustering → Scatter Plot 

3. Resume Screening Dataset: Employee Hiring Data 

4. Customer Segmentation Dataset: Customer Segmentation Dataset 

• Activities: 

1. Screen resumes based on job fit. 

2. Segment customers by behaviour or demographics. 

3. Discuss automation benefits and risks. 

• Outcome: Students explore how AI enhances HR and marketing efficiency. 

 

 

Note: The Tools suggested above are tentative. Teacher/Student is free to choose any 

other similar tool to execute the said lab experiments. 

*******@@@****** 

 

https://www.kaggle.com/datasets/yeanzc/telco-customer-churn-ibm-dataset
https://www.kaggle.com/datasets/malsha/employee-hiring-data
https://www.kaggle.com/datasets/teddybrown414/customer-segmentation-dataset-from-a-company
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

3. APPLICABLE TO HISTORY, ECONOMICS, POLITICAL SCIENCE, LINGUISTICS AND 

OTHER HUMANITIES  

Semester Paper Code Paper Title Hrs./Week Credits  

II 25SEC201 Applications of Artificial Intelligence 4 4 

Course Objectives:  
1. Provide a foundation in the AI ecosystem, including hardware, cloud, and edge 

platforms, in a non-technical way for Arts and Social Sciences students. 

2. Familiarize students with data types, sources, and public repositories that fuel AI 

applications in society and humanities. 

3. Explain the process of preparing and managing AI data pipelines through collection, 

annotation, and cleaning. 

4. Explore real-world applications of AI in arts, culture, literature, linguistics, and 

languages. 

5. Introduce applications of AI in social sciences such as economics, political science, 

psychology, history, and sociology, with an emphasis on ethics and responsible 

adoption. 

Course Learning Outcomes:  
 Upon successful completion of the course, a student will be able to:  

6. Explain the AI ecosystem (hardware, cloud, edge devices) and its societal relevance. 

7. Differentiate data types and identify public datasets relevant to social sciences, arts, 

and humanities. 

8. Describe the steps of an AI data pipeline (collection, annotation, cleaning, 

preparation) in simple terms. 

9. Illustrate the role of AI in arts, languages, and cultural heritage with practical, real-

world examples. 

10. Analyse applications of AI in social sciences (economics, politics, psychology, history, 

and society) and evaluate ethical concerns. 

UNIT – I:  Infrastructure and Platforms for Building Applications using AI 
Hardware used in building AI applications: Processors - CPU, GPU, TPU, NPU, Memory - 

RAM, VRAM, Storage - HDD, SSD. Platforms for building applications using AI: Online 

platforms (Example - Google AutoML, H2O.ai, Teachable Machine or similar platforms - 

for practice only); Desktop (No-code/Low- code) platforms (Orange Data Mining, KNIME, 

Weka, RapidMiner or similar tools - for practice only). Edge AI: Concept; Applications in 

daily life in devices like Refrigerators, Led Bulbs, Surveillance Cameras, Micro Ovens, 

Smart Cars/Scooters; Edge AI in smart Appliances. 
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UNIT – II: Foundations of Datatypes, Ethics & Utility in Building Applications using AI   

Importance of data in building AI applications: Data as the fuel for AI, Role of big data in 

training AI models. Conceptual Foundations of Data: Data vs. Information vs. Knowledge. 

Structure of Data: Structured, Semi-Structured, and Unstructured Data.  

Modalities of Data: Text, Image, Audio, Video, Tabular, Time-Series, and Spatial Data.  

Formats of Data: Text Formats (CSV, JSON, XML), Image Formats (JPEG, GIF, PNG), 

Audio/Video (MP3, WAV, MP4, AVI). 

Data Repositories: Definition of public Datasets; Definition of private Datasets; 

Importance of Public Datasets, Popular Public Dataset Repositories (Example - Kaggle, 

Hugging Face Datasets, UCI Machine Learning Repository, Google Dataset Search or 

similar ones - for demonstration only), Dataset licensing and usage rights. 

Ethics, Privacy in Data Usage: Privacy concerns related to data usage; Regulations 

governing data usage - GDPR, HIPAA (Overview), Ethical use of data, Responsible AI data 

practices. 

UNIT – III: The AI Data Pipeline: From Collection to Model Readiness 

The AI Data Pipeline: Stages and Components: Key Stages (Data Collection, Annotation, 

Preprocessing, Splitting, Feeding into AI Models. Core Components: Ingestion, Storage, 

Processing, Validation, Delivery. Data Collection Methods for AI: Manual Input (Surveys, 

forms, human-curated entries), Sensors & IoT Devices (Real-time data from physical 

environments), System Logs & Transactions, Web Scraping (Automated extraction from 

websites), APIs (Structured data access from external platforms). 

Data Annotation and Labelling: Definition & Importance; Annotation Methods: Manual 

Annotation, Automated Annotation; Types of Annotation: Classification, Bounding Boxes, 

Segmentation, Transcription, Named Entity Recognition (NER). 

Data Cleaning and Preprocessing: Importance of data cleaning; Understanding “Dirty” 

Data: Missing Values, Duplicates, Incorrect Formats, Outliers, Noise; Steps in Data 

Cleaning: Identify Issues, Handle Errors (Imputation, Removal), Validate Cleaned Data. 

Data Splitting: Splitting data into training set and test set. Data Transformation 

Techniques: Normalization, Transformation, Feature Engineering (Conceptual).  

UNIT – IV: AI in Social Sciences and Society 
AI in Economics: Predicting market trends, consumer behaviour, and economic 

forecasting. AI in Political Science & Public Policy: Social media analysis for political 

campaigns, Opinion mining & election trend prediction. AI in Psychology & Sociology: 

Emotion recognition from facial expressions and text, AI chatbots in mental health 

counselling (conceptual). AI in History & Society: Digital archives and historical 

document analysis, AI for preserving ancient languages and scripts, Social impact  of AI 

on jobs, privacy, and democracy. 

UNIT – V: AI in Arts, Languages and Cultural Studies 

AI in Literature & Languages: Machine translation (Google Translate, DeepL), Sentiment 

analysis in literature and media reviews, AI-assisted creative writing (chatbots, story 

generators, poetry) 
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AI in Arts & Culture: AI in music composition & art generation (painting, film scripts), 

Digitization and preservation of cultural heritage using AI, Identifying fake art and 

forgeries. 

Textbooks: 
1. Data Science for Beginners, Andrew Park 

(Introductory concepts of data types, collection, cleaning, and visualization without coding) 

2. AI Basics for Non-Programmers, Tom Taulli 

(Clear explanations of AI data lifecycle and real-world use cases) 

3. Data Preparation for Machine Learning, Jason Brownlee 

(Conceptual understanding of dataset quality, preprocessing, and pipelines) 

4. Hands-On Data Science for Non-Programmers, David Meerman Scott 

(Spreadsheet-based data exploration and visualization) 

5. You Look Like a Thing and I Love You – Janelle Shane 

References: 
1. Kaggle Dataset Search, https://www.kaggle.com/datasets  

2. Google Dataset Search, https://datasetsearch.research.google.com 

3. UCI Machine Learning Repository, https://archive.ics.uci.edu 

4. Hugging Face Datasets, https://huggingface.co/datasets 

5. Open Government Data (India), https://data.gov.in 

*******@@@****** 

http://www.kaggle.com/datasets
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

3. APPLICABLE TO HISTORY, ECONOMICS, POLITICAL SCIENCE, LINGUISTICS AND 

OTHER HUMANITIES 

Semester Paper Code Paper Title Hrs./Week Credits  

II 25SEC201 
Applications of Artificial 

Intelligence Practical 
2 0 

Suggested Lab Practical (No Coding): 
1. Lab 1: Explore Open Data (Economics / Sociology) 

• Tool: Our World in Data or World Bank Data Explorer 

(https://data360.worldbank.org/en/search) 

• Task: Choose indicators (e.g., Literacy, GDP per capita, Poverty, Unemployment). 

• Procedure: 

1. Open World Bank / Our World in Data. 

2. Select one country or compare multiple countries. 

3. Use the interactive charts to see historical trends. 

• Observation: How does education level impact income or health? 

• Outcome: Understand correlations between socio-economic indicators. 

2. Lab 2: Data Annotation (NER & Classification) 

• Tool: Prodigy Demo (https://demo.prodi.gy/) -free online demo, no install 

• Activity: 

1. Try Named Entity Recognition (NER) demo. 

2. Highlight organizations, people, and places in sample text. 

3. Compare manual vs. automated annotation. 

• Outcome: Students understand manual vs. automated annotation and why 

labelling is crucial. 

3. Lab 3: Automatic Text Classification for Sociology 

• Tool: Text2Data Sentiment Analysis Demo (https://text2data.com/Demo) -free 

online demo 

• Task: Copy-paste 5 messages related to climate change, caste or gender. 

• Observation: Tool classifies them as Positive, Neutral, or Negative. 

• Outcome: Understand “annotation” and “classification labels. 

4. Lab 4: Word Clouds for Political Speeches (Languages / Political Science) 

• Tool: WordArt Cloud Generator (https://wordart.com/create) - Free Online 

• Procedure: 

1. Copy a Prime Minister’s speech or Economic Budget highlights. 

2. Paste into WordArt. 

3. Generate a word cloud → biggest words = most repeated. 

• Observation: Main themes in political communication. 

• Outcome: Learn how text visualization shows political/economic priorities. 

https://data360.worldbank.org/en/search
https://demo.prodi.gy/
https://text2data.com/Demo
https://wordart.com/create
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5. Lab 5: Bias in Job Advertisements (Sociology / Gender Studies) 

• Tool: Gender Decoder for Job Ads (https://gender-decoder.katmatfield.com/) -

Free Online or Any other related tool 

• Procedure: 

1. Copy text from 5 job advertisements. 

2. Paste into the gender bias detector. 

3. Note masculine vs feminine coded words. 

• Observation: How language influences gendered hiring. 

• Outcome: Awareness of AI in analyzing workplace bias. 

6. Lab 6: Language Detection & Translation (Languages / Linguistics) 

• Tool: Google Translate (https://translate.google.co.in/) 

• Task: Enter text in regional/foreign languages. 

• Procedure: 

1. Paste short paragraph in Telugu, Hindi, French, etc. 

2. Translate into English. 

3. Reverse-translate to see changes. 

• Observation: Which meanings are lost in translation? 

• Outcome: Students understand AI’s strengths/limits in translation 

7. Lab 7: Text Summarization of Articles (Languages / Literature) 

• Tool: SMMRY (https://smmry.com/) or Scholarcy Free Summarizer 

(https://www.scholarcy.com/article-summarizer) 

• Task: Take a long article or essay. 

• Procedure: 

1. Paste article into tool. 

2. Generate summary. 

3. Compare AI summary vs. student’s manual summary. 

• Observation: AI captures main ideas but may miss nuances. 

• Outcome: Learn how AI helps in academic reading & summarization. 

8. Lab 8: Talk to a Free Chatbot 

• Tool: ChatGPT Free or Poe or any other related tool 

• Activity: Students ask questions like: 

1. “Tell me a Telugu proverb and its meaning.” 

2. “Explain World War II in 5 simple lines.” 

• Outcome: Data delivery/output stage - AI as a dialogue system. 

9. Lab 9: Story Generator (Creative Writing / Literature) 

• Tool: AI Dungeon (https://play.aidungeon.com/) - free play or DeepAI Text 

Generator (https://deepai.org/chat/text-generator) 

• Activity: Give a starting line (e.g., “Once upon a time in Amaravati…”) → AI 

continues story 

• Outcome: How training data influences creativity in AI. 

10. Lab 10: AI Art Generator (Culture & Arts) 

• Tool: DeepAI Text-to-Image (free) (https://deepai.org/machine-learning- 

https://gender-decoder.katmatfield.com/
https://translate.google.co.in/
https://smmry.com/
http://www.scholarcy.com/article-summarizer)
https://chat.openai.com/
https://play.aidungeon.com/
https://deepai.org/chat/text-generator
https://deepai.org/machine-learning-model/text2img
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model/text2img) or any other related tool 

• Activity: Ask students to generate: 

1. “A painting of Bharat Mata in Picasso style.” 

2. “Hyderabad Charminar in futuristic design.” 

• Outcome: Data pipeline applied to images. 

11. Lab 11: AI Music Generation with Soundraw (Free Trial)  

• Tool: Soundraw.io 

• Steps: 

1. Open the website → Click Create Music.  

2. Select Mood (happy, sad, chill, dramatic).  

3. Select Genre (pop, jazz, cinematic, lo-fi, etc.).  

4. The AI will generate a full instrumental track. 

5. You can adjust instruments, tempo, and structure. 

• Outcome: Students understand how AI composes music automatically based on 

mood/genre → linking to psychology, culture, and media studies. 

12. Lab 12: Chatbot Roleplay (History / Social Science) 

• Tool: Character.AI (free, no coding)- https://character.ai/ 

• Activity: Talk to AI characters like “Einstein” or “Shakespeare” and ask them 

questions. You can try with other AI characters and experiment. 

• Learning: How AI mimics personalities using training data 

 

Note: The Tools suggested above are tentative. Teacher/Student is free to choose any 

other similar tool to execute the said lab experiments. 

*******@@@****** 

  

https://deepai.org/machine-learning-model/text2img
https://character.ai/
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

4. APPLICABLE TO MATHEMATICS, PHYSICS, CHEMISTRY AND ANY OTHER 

MATHEMATICAL SCIENCES  

Semester Paper Code Paper Title Hrs./Week Credits  

II 25SEC201 Applications of Artificial Intelligence 4 4 

Course Objectives:  
1. Provide a foundational understanding of AI platforms, data pipelines, and their 

importance in the physical sciences. 

2. Introduce real-world datasets and public repositories relevant to physics, chemistry, 

mathematics, and earth sciences. 

3. Explain how AI is applied to solve scientific problems, discover patterns, and support 

research in physical sciences in a simple, non-coding manner. 

4. Highlight ethical concerns, data challenges, and the future of AI-driven discoveries in 

physical sciences. 

Course Learning Outcomes:  
 Upon successful completion of the course, a student will be able to:  

1. Explain the AI ecosystem (hardware, cloud, and edge devices) in relation to physical 

sciences applications. 

2. Identify scientific data types and public repositories relevant to physics, chemistry, 

mathematics, and earth sciences. 

3. Describe the process of preparing and managing scientific data pipelines. 

4. Illustrate the role of AI in solving real-world scientific challenges in physics, chemistry, 

mathematics, and earth sciences. 

5. Analyse ethical, environmental, and societal impacts of AI-driven scientific 

applications. 

UNIT – I:  Infrastructure and Platforms for Building Applications using AI 
Hardware used in building AI applications: Processors - CPU, GPU, TPU, NPU, Memory - 

RAM, VRAM, Storage - HDD, SSD. Platforms for building applications using AI: Online 

platforms (Example - Google AutoML, H2O.ai, Teachable Machine or similar platforms - 

for practice only); Desktop (No-code/Low- code) platforms (Orange Data Mining, KNIME, 

Weka, RapidMiner or similar tools - for practice only). Edge AI: Concept; Applications in 

daily life in devices like Refrigerators, Led Bulbs, Surveillance Cameras, Micro Ovens, 

Smart Cars/Scooters; Edge AI in smart Appliances. 

UNIT – II: Foundations of Datatypes, Ethics & Utility in Building Applications using AI   

Importance of data in building AI applications: Data as the fuel for AI, Role of big data in 

training AI models. Conceptual Foundations of Data: Data vs. Information vs. Knowledge. 

Structure of Data: Structured, Semi-Structured, and Unstructured Data.  

Modalities of Data: Text, Image, Audio, Video, Tabular, Time-Series, and Spatial Data.  
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Formats of Data: Text Formats (CSV, JSON, XML), Image Formats (JPEG, GIF, PNG), 

Audio/Video (MP3, WAV, MP4, AVI). 

Data Repositories: Definition of public Datasets; Definition of private Datasets; 

Importance of Public Datasets, Popular Public Dataset Repositories (Example - Kaggle, 

Hugging Face Datasets, UCI Machine Learning Repository, Google Dataset Search or 

similar ones - for demonstration only), Dataset licensing and usage rights. 

Ethics, Privacy in Data Usage: Privacy concerns related to data usage; Regulations 

governing data usage - GDPR, HIPAA (Overview), Ethical use of data, Responsible AI data 

practices. 

UNIT – III: The AI Data Pipeline: From Collection to Model Readiness 

The AI Data Pipeline: Stages and Components: Key Stages (Data Collection, Annotation, 

Preprocessing, Splitting, Feeding into AI Models. Core Components: Ingestion, Storage, 

Processing, Validation, Delivery. Data Collection Methods for AI: Manual Input (Surveys, 

forms, human-curated entries), Sensors & IoT Devices (Real-time data from physical 

environments), System Logs & Transactions, Web Scraping (Automated extraction from 

websites), APIs (Structured data access from external platforms). 

Data Annotation and Labelling: Definition & Importance; Annotation Methods: Manual 

Annotation, Automated Annotation; Types of Annotation: Classification, Bounding Boxes, 

Segmentation, Transcription, Named Entity Recognition (NER). 

Data Cleaning and Preprocessing: Importance of data cleaning; Understanding “Dirty” 

Data: Missing Values, Duplicates, Incorrect Formats, Outliers, Noise; Steps in Data 

Cleaning: Identify Issues, Handle Errors (Imputation, Removal), Validate Cleaned Data. 

Data Splitting: Splitting data into training set and test set. Data Transformation 

Techniques: Normalization, Transformation, Feature Engineering (Conceptual).  

UNIT – IV: AI in Physical Sciences (Physics & Chemistry Applications) 

AI in Physics: AI for analyzing astronomical images (identifying galaxies, stars, 

exoplanets), CERN Datasets for Particle Physics. AI  in  material  science:  discovering  new  

superconductors  and  quantum  materials. AI in energy: predicting power grid loads, 

optimizing solar and wind energy systems. AI in Chemistry: Protein structure prediction 

(AlphaFold). AI in drug discovery – virtual screening of compounds. AI in chemistry - 

reaction outcome & material property prediction. 

UNIT – V: AI in Mathematics and Earth Sciences 

AI in Mathematics: Pattern recognition in large datasets (fractals, chaos systems, number 

theory) Automated theorem proving and symbolic mathematics. AI in optimization 

problems (transport, logistics, resource allocation)(Explore  the  Wolfram  Alpha  Tool:  

https://www.wolframalpha.com/examples/mathematics). 

AI in Earth Sciences: Climate modeling: AI predicting weather patterns, cyclones, and 

long-term climate change. Remote Sensing: AI analysing satellite images for 

deforestation, urbanization, and natural resource mapping. Earthquake and natural 

disaster prediction using sensor networks. AI in Geology: identifying mineral deposits, 

oil, and groundwater reserves. 

https://www.wolframalpha.com/examples/mathematics
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Textbooks: 
1. Data Science for Beginners, Andrew Park 

(Introductory concepts of data types, collection, cleaning, and visualization without coding) 

2. AI Basics for Non-Programmers, Tom Taulli 

(Clear explanations of AI data lifecycle and real-world use cases) 

3. Data Preparation for Machine Learning, Jason Brownlee 

(Conceptual understanding of dataset quality, preprocessing, and pipelines) 

4. Hands-On Data Science for Non-Programmers, David Meerman Scott 

(Spreadsheet-based data exploration and visualization) 

5. You Look Like a Thing and I Love You – Janelle Shane 

References: 
1. AI in Astronomy: https://www.borntoengineer.com/how-is-artificial-intelligence-is-

helping-us-learn-about-the-universe  

https://primo.ai/index.php/Astronomy 

2. CERN datasets for Particle Physics: https://opendata.cern.ch/ 

3. AI in Material Science: 

https://deepmind.google/discover/blog/millions-of-new-materials-discovered-

with-deep-learning/ 

https://www.temasek.com.sg/content/dam/temasek-corporate/news-and- 

views/resources/reports/ai-meets-materials.pdf 

4. AI in Energy: https://www.xenonstack.com/blog/ai-renewable-energy-production 
https://www.sandtech.com/insight/how-ai-is-transforming-the-future-in-energy-management/ 

5. AI in Chemistry: https://chemintelligence.com/ai-for-chemistry 

https://deepmind.google/science/alphafold/ 

https://aimagazine.com/articles/alphafold-2-the-ai-system-that-won-google-a-nobel-prize  
https://blog.google/technology/ai/google-deepmind-isomorphic-alphafold-3-ai- model/#life-molecules 

6. AI in Drug Discovery: 

https://www.ddw-online.com/the-promise-of-ai-advancing-drug-discovery-with-

ultra- large-library-processing-29063-202403/ 
https://www.medchemexpress.com/ai-driven-drug-

screening.html?srsltid=AfmBOoqhDeVNqW9S5vn1m4FZargNAKEFdOKaPvwsnOIzen QEEJoWkz8J 

7. AI in Optimization Problems: 

https://throughput.world/blog/ai-in-transportation-and-logistics/ 

https://codewave.com/insights/ai-transforming-transportation-logistics/ 

8. AI in Remote Sensing: https://www.satimagingcorp.com/applications/artificial-

intelligence-ai/ 

*******@@@****** 

https://www.borntoengineer.com/how-is-artificial-intelligence-is-helping-us-learn-about-
https://www.borntoengineer.com/how-is-artificial-intelligence-is-helping-us-learn-about-
https://www.borntoengineer.com/how-is-artificial-intelligence-is-helping-us-learn-about-the-universe
https://primo.ai/index.php/Astronomy
https://opendata.cern.ch/
https://deepmind.google/discover/blog/millions-of-new-materials-discovered-with-deep-learning/
https://deepmind.google/discover/blog/millions-of-new-materials-discovered-with-deep-learning/
https://deepmind.google/discover/blog/millions-of-new-materials-discovered-with-deep-learning/
https://www.temasek.com.sg/content/dam/temasek-corporate/news-and-
https://www.temasek.com.sg/content/dam/temasek-corporate/news-and-views/resources/reports/ai-meets-materials.pdf
https://www.xenonstack.com/blog/ai-renewable-energy-production
https://www.sandtech.com/insight/how-ai-is-transforming-the-future-in-energy-
https://www.sandtech.com/insight/how-ai-is-transforming-the-future-in-energy-management/
https://chemintelligence.com/ai-for-chemistry
https://deepmind.google/science/alphafold/
https://aimagazine.com/articles/alphafold-2-the-ai-system-that-won-google-a-nobel-prize
https://blog.google/technology/ai/google-deepmind-isomorphic-alphafold-3-ai-
https://blog.google/technology/ai/google-deepmind-isomorphic-alphafold-3-ai-model/#life-molecules
https://www.ddw-online.com/the-promise-of-ai-advancing-drug-discovery-with-ultra-
https://www.ddw-online.com/the-promise-of-ai-advancing-drug-discovery-with-ultra-
https://www.ddw-online.com/the-promise-of-ai-advancing-drug-discovery-with-ultra-large-library-processing-29063-202403/
https://www.medchemexpress.com/ai-driven-drug-
https://www.medchemexpress.com/ai-driven-drug-
https://www.medchemexpress.com/ai-driven-drug-screening.html?srsltid=AfmBOoqhDeVNqW9S5vn1m4FZargNAKEFdOKaPvwsnOIzenQEEJoWkz8J
https://www.medchemexpress.com/ai-driven-drug-screening.html?srsltid=AfmBOoqhDeVNqW9S5vn1m4FZargNAKEFdOKaPvwsnOIzenQEEJoWkz8J
https://throughput.world/blog/ai-in-transportation-and-logistics/
https://codewave.com/insights/ai-transforming-transportation-logistics/
https://www.satimagingcorp.com/applications/artificial-intelligence-ai/
https://www.satimagingcorp.com/applications/artificial-intelligence-ai/
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

4. APPLICABLE TO MATHEMATICS, PHYSICS, CHEMISTRY AND ANY OTHER 

MATHEMATICAL SCIENCES 

Semester Paper Code Paper Title Hrs./Week Credits  

II 25SEC201 
Applications of Artificial 

Intelligence Practical 
2 0 

Suggested Lab Practical (No Coding): 
1. Lab 1 - Exploring Public Datasets (Orange Data Mining) 

• Visit a public repository (Kaggle, UCI, data.gov.in) 

• Download a dataset (e.g., rainfall data, literacy rates, or traffic accident statistics) 

• Procedure: 

1. Open Orange → Add File widget → Load a CSV (e.g., Titanic dataset). 

2. Connect to Data Table → View rows/columns. 

3. Connect to Data Info → Check attributes, data types. 

4. View in Data Table and Distributions widget. 

• Observation: Note numeric, categorical, missing values. 

• Outcome: Students understand structured data format in CSV. 

2. Lab 2 - Exploring Scientific Datasets  

• Dataset: Earth datasets, Physics Particle Dataset  

• Tool: Orange Data Mining. 

• Activity: 

1. Load a CSV (e.g., earthquake dataset: 

https://www.kaggle.com/datasets/warcoder/earthquake-dataset  

2. Physics particle dataset: https://www.kaggle.com/datasets/dsfelix/physics-

particles  

3. Use Data Table + Distributions to view features. 

4. Compare categorical vs numerical attributes. 

• Outcome:  Students  understand  how  scientific  datasets  are  structured  and  

visualized. 

3. Lab 3 - Understanding Dataset Metadata and Formats 

• Take two datasets in different formats (CSV, JSON) 

• View metadata (description, features, size, license) 

• Compare domain-specific datasets (e.g., medical vs. finance) 

4. Lab 4 - Data Annotation Exercise 

• Use MakeSense.ai or VGG Image Annotator (VIA) 

• Annotate 10 sample images (traffic signs, fruits, or medical scans) 

• Export annotations in XML or YOLO format 

• Discuss annotation errors and challenges 

5. Lab 5 - Data Cleaning and Visualization (Orange Data Mining) 

https://www.kaggle.com/datasets/warcoder/earthquake-dataset
https://www.kaggle.com/datasets/dsfelix/physics-particles
https://www.kaggle.com/datasets/dsfelix/physics-particles
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• Aim: To clean dirty data and visualize categorical and numeric attributes. 

• Procedure: 

1. Load dataset. 

2. Connect File → Edit Domain (to change types) and Impute (to fill missing 

values). 

3. Compare cleaned vs. original in Data Table. 

4. Distributions widget. 

5. Check various features distribution. 

(Optional: Create simple bar charts/line charts to visualize trends using Google 

Looker Studio) 

• Observation: Missing values filled with mean/median., Graphical representation 

of data. 

• Outcome: Learn importance of data cleaning., Students learn importance of 

visualization in preprocessing. 

6. Lab 6: Train/Test Split in Orange 

• Aim: To split dataset for AI training/testing. 

• Procedure: 

1. Load Titanic dataset. 

2. Connect File → Data Sampler (70% train, 30% test). 

3. Connect outputs to Data Table widgets to view. 

• Observation: Students see two different subsets. 

• Outcome: Concept of model validation using split data. 

7. Lab 7 – Material Science Data Exploration (Chemistry + Physics) 

• Dataset: Materials Project Database (https://next-gen.materialsproject.org/ ) OR 

Kaggle chemistry  datasets(https://www.kaggle.com/competitions?tagIds=7402-Chemistry).  

• Tool: Orange Data Mining.  

• Activity:  

1. Load material/compound dataset (e.g., band gap, conductivity).  

2. Visualize trends (scatter plots, bar charts). 

3. Identify correlations between features. 

• Outcome: Students see how AI identifies new material properties. 

8. Lab 8 – Earthquake Prediction Data Analysis (Earth Sciences)  

• Dataset: USGS Earthquake Dataset (public):  

• https://www.kaggle.com/datasets/rupindersinghrana/usgs-earthquakes-2024  

• Tool: Orange Data Mining 

• Activity: 

1. Load earthquake data (time, magnitude, depth). 

2. Plot frequency over time & regions. 

3. Perform simple clustering (e.g., k-means in Orange). 

• Outcome: Understand how AI detects seismic patterns. 

9. Lab 9– Climate Data Visualization (Earth Sciences) 

• Dataset: NASA GISS climate dataset (https://data.giss.nasa.gov/gistemp/) / FAO 

https://next-gen.materialsproject.org/
https://www.kaggle.com/competitions?tagIds=7402-Chemistry
https://www.kaggle.com/datasets/rupindersinghrana/usgs-earthquakes-2024
https://data.giss.nasa.gov/gistemp/
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rainfall data (https://www.fao.org/aquastat/en/geospatial-information/climate-

information) . 

• Tool: Google Looker Studio (free dashboard tool).  

• Activity: 

1. Import CSV of temperature/rainfall data. 

2. Build trend graphs and heat maps. 

• Outcome: Learn visualization of climate patterns & anomalies. 

10. Lab 10 – Chemical Compound Classification (Chemistry)  

• Prerequisite: Discuss conceptually about Clustering 

• Dataset: PubChem / ChEMBL chemical datasets. 

(https://pubchem.ncbi.nlm.nih.gov/source/ChEMBL) 

• Tool: ChemMine Tools (free web-based). (https://chemminetools.ucr.edu/) 

• Activity: 

1. Input chemical structures or SMILES notations. 

2. Predict chemical similarity clusters. 

3. Analyse “drug-likeness” properties. 

• Outcome: Understanding AI in drug discovery & reaction prediction. 

11. Lab 11 – Symbolic Mathematics Solver (Mathematics)  

• Dataset: Wolfram Alpha examples / OpenMath datasets. 

• Tool: MathPix (OCR) + Symbolab / WolframAlpha (free tier)- 

https://www.wolframalpha.com/ 

• Activity: 

1. Input handwritten/scanned math problems using MathPix. 

2. Use Wolfram Alpha to see symbolic solving. 

3. Compare AI vs manual solution steps. 

• Outcome: Understand automated theorem proving and symbolic AI. 

12. Lab 12 – Explore the Mathematical AI tool 

• Tool: WolframAlpha (free tier)- https://www.wolframalpha.com/ 

• Activity: Solve specific math problems or find information on Mathematical 

subjects and topics. 

• Outcome: Understand deep computational power of AI tools in solving Math 

Problems. 

13. Lab 13 – Explore various Remote Sensing Datasets  

• Tool: https://developers.google.com/earth-engine/datasets/  

• Activity: 

1. Explore any Three Satellite Sensor Datasets 

2. Identify the Significance and the Period of Availability 

3. Study various bands available in the data 

• Outcome: Understand various Remote Sensing Datasets. 

Note: The Tools suggested above are tentative. Teacher/Student is free to choose any 

other similar tool to execute the said lab experiments. 

*******@@@****** 

https://www.fao.org/aquastat/en/geospatial-information/climate-information
https://www.fao.org/aquastat/en/geospatial-information/climate-information
https://pubchem.ncbi.nlm.nih.gov/source/ChEMBL
https://chemminetools.ucr.edu/
https://www.wolframalpha.com/
https://www.wolframalpha.com/
https://developers.google.com/earth-engine/datasets/
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

5. APPLICABLE TO COMPUTER SCIENCE, DATA SCIENCE, ARTIFICIAL INTELLIGENCE, 

COGNITIVE SYSTEMS, DATA ANALYTICS, CLOUD COMPUTING, CYBER SECURITY AND 

ANY OTHER COMPUTER SCIENCE ALLIED STREAMS 

Semester Paper Code Paper Title Hrs./Week Credits  

II 25SEC201 Applications of Artificial Intelligence 4 4 

Course Objectives:  
1. Provide a foundation in the AI ecosystem, including hardware, cloud, and edge 

platforms relevant to Computer science. 

2. Familiarize students with different types of datasets and public repositories used in 

AI research. 

3. Develop skills in building AI data pipelines through collection, annotation, cleaning, 

and preprocessing. 

4. Expose students to no-code AI platforms, vibe coding, and workflow automation tools 

for rapid AI application development. 

5. Introduce applications of AI in networking, cybersecurity, and digital forensics, 

highlighting both opportunities and challenges. 

Course Learning Outcomes:  
 Upon successful completion of the course, a student will be able to:  

1. Explain the role of AI hardware, edge devices, and cloud platforms in enabling 

applications in Computer Science. 

2. Differentiate data types and utilize public datasets relevant to AI. 

3. Design and implement a conceptual AI data pipeline for solving problems. 

4. Apply no-code/low-code AI platforms, vibe coding tools, and workflow automation 

for simple AI-powered applications. 

5. Evaluate the role of AI in networking, cybersecurity, and digital forensics, and discuss 

its challenges and future scope. 

UNIT – I:  Infrastructure and Platforms for Building Applications using AI 
Hardware used in building AI applications: Processors - CPU, GPU, TPU, NPU, Memory - 

RAM, VRAM, Storage - HDD, SSD. Platforms for building applications using AI: Online 

platforms (Example - Google AutoML, H2O.ai, Teachable Machine or similar platforms - 

for practice only); Desktop (No-code/Low- code) platforms (Orange Data Mining, KNIME, 

Weka, RapidMiner or similar tools - for practice only). Edge AI: Concept; Applications in 

daily life in devices like Refrigerators, Led Bulbs, Surveillance Cameras, Micro Ovens, 

Smart Cars/Scooters; Edge AI in smart Appliances. 

UNIT – II: Foundations of Datatypes, Ethics & Utility in Building Applications using AI   

Importance of data in building AI applications: Data as the fuel for AI, Role of big data in 

training AI models. Conceptual Foundations of Data: Data vs. Information vs. Knowledge. 
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Structure of Data: Structured, Semi-Structured, and Unstructured Data.  

Modalities of Data: Text, Image, Audio, Video, Tabular, Time-Series, and Spatial Data.  

Formats of Data: Text Formats (CSV, JSON, XML), Image Formats (JPEG, GIF, PNG), 

Audio/Video (MP3, WAV, MP4, AVI). 

Data Repositories: Definition of public Datasets; Definition of private Datasets; 

Importance of Public Datasets, Popular Public Dataset Repositories (Example - Kaggle, 

Hugging Face Datasets, UCI Machine Learning Repository, Google Dataset Search or 

similar ones - for demonstration only), Dataset licensing and usage rights. 

Ethics, Privacy in Data Usage: Privacy concerns related to data usage; Regulations 

governing data usage - GDPR, HIPAA (Overview), Ethical use of data, Responsible AI data 

practices. 

UNIT – III: The AI Data Pipeline: From Collection to Model Readiness 

The AI Data Pipeline: Stages and Components: Key Stages (Data Collection, Annotation, 

Preprocessing, Splitting, Feeding into AI Models. Core Components: Ingestion, Storage, 

Processing, Validation, Delivery. Data Collection Methods for AI: Manual Input (Surveys, 

forms, human-curated entries), Sensors & IoT Devices (Real-time data from physical 

environments), System Logs & Transactions, Web Scraping (Automated extraction from 

websites), APIs (Structured data access from external platforms). 

Data Annotation and Labelling: Definition & Importance; Annotation Methods: Manual 

Annotation, Automated Annotation; Types of Annotation: Classification, Bounding Boxes, 

Segmentation, Transcription, Named Entity Recognition (NER). 

Data Cleaning and Preprocessing: Importance of data cleaning; Understanding “Dirty” 

Data: Missing Values, Duplicates, Incorrect Formats, Outliers, Noise; Steps in Data 

Cleaning: Identify Issues, Handle Errors (Imputation, Removal), Validate Cleaned Data. 

Data Splitting: Splitting data into training set and test set. Data Transformation 

Techniques: Normalization, Transformation, Feature Engineering (Conceptual).  

UNIT – IV: AI-Powered No-Code Development: Vibe Coding and Workflow Automation 

Vibe Coding: Concept & Workflow: What is Vibe Coding and how it works; Comparison: 

Vibe Coding vs. traditional programming; Tools Overview: Google AI Studio, Firebase 

Studio, Replit, Cursor, Windsurf (for demonstration and practice only); Tool Selection: 

Choosing the right platform for your needs; Benefits & Challenges: Advantages and 

limitations of Vibe Coding; Paradigm Shift: From code-centric to prompt-driven 

development; Prompt Crafting: Structure and examples of effective app prompts. 

Workflow Automation using AI: Fundamentals: What is workflow automation and its 

relevance in the AI era; Real-world Applications: Auto-email responses, Feedback 

summarization, Social media alerts & analytics; Toolset Overview: Zapier, Power 

Automate, n8n, Lindy and other similar tools (for demonstration and practice only); 

Choosing the Right Tool: Features, use cases, and integration potential. 

UNIT – V: AI in Networks, Cybersecurity, and Forensics 

AI in Networking: Need of AI in Network Management, How AI works in Traffic Prediction 

& Intrusion Detection, Uses of AI in Optimization, Fault Management, and Routing 
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AI in Cyber Security: Need of AI in Cyber Security, How AI works in Cyber Security, Uses 

of AI in Cyber Security, Challenges and Considerations of AI in Cyber Security 

AI in Digital Forensics: How AI enhance digital forensic investigations, Role of AI in cyber- 

forensic evidence acquisition and analysis, Overcoming challenges and limitations of AI 

in forensics, The future outlook for AI-powered forensic tools. 

Textbooks: 
1. Data Science for Beginners, Andrew Park 

(Introductory concepts of data types, collection, cleaning, and visualization without coding) 

2. AI Basics for Non-Programmers, Tom Taulli 

(Clear explanations of AI data lifecycle and real-world use cases) 

3. Data Preparation for Machine Learning, Jason Brownlee 

(Conceptual understanding of dataset quality, preprocessing, and pipelines) 

4. Hands-On Data Science for Non-Programmers, David Meerman Scott 

(Spreadsheet-based data exploration and visualization) 

5. You Look Like a Thing and I Love You – Janelle Shane 

6. Vibe coding: https://cloud.google.com/discover/what-is-vibe-coding 

https://www.ibm.com/think/topics/vibe-coding 

https://firebase.google.com/docs/studio/prompting 

7. Workflow Automation: https://www.ibm.com/think/topics/workflow-automation  

https://www.ibm.com/think/topics/ai-workflow   

https://n8n.io/ 

8. AI in Cyber Security: https://www.geeksforgeeks.org/ethical-hacking/ai-in-

cybersecurity/ 

9. AI in Networks: 

https://www.cisco.com/site/us/en/learn/topics/artificial-intelligence/what-is-ai-

in-networking.html 

10. AI in Digital Forensics: 

https://www.eccouncil.org/cybersecurity-exchange/cyber-talks/ai-and-ml-in-

digital-forensics-the-future-of-forensic-investigations/ 

References: 
1. Kaggle Dataset Search, https://www.kaggle.com/datasets  

2. Google Dataset Search, https://datasetsearch.research.google.com 

3. UCI Machine Learning Repository, https://archive.ics.uci.edu 

4. Hugging Face Datasets, https://huggingface.co/datasets 

5. Open Government Data (India), https://data.gov.in 

 

*******@@@****** 

https://cloud.google.com/discover/what-is-vibe-coding
https://www.ibm.com/think/topics/vibe-coding
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https://www.cisco.com/site/us/en/learn/topics/artificial-intelligence/what-is-ai-in-networking.html
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https://www.eccouncil.org/cybersecurity-exchange/cyber-talks/ai-and-ml-in-digital-
https://www.eccouncil.org/cybersecurity-exchange/cyber-talks/ai-and-ml-in-digital-forensics-the-future-of-forensic-investigations/
http://www.kaggle.com/datasets
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

5. APPLICABLE TO COMPUTER SCIENCE, DATA SCIENCE, ARTIFICIAL INTELLIGENCE, 

COGNITIVE SYSTEMS, DATA ANALYTICS, CLOUD COMPUTING, CYBER SECURITY AND 

ANY OTHER COMPUTER SCIENCE ALLIED STREAMS 

Semester Paper Code Paper Title Hrs./Week Credits  

II 25SEC201 
Applications of Artificial 

Intelligence Practical 
2 0 

Suggested Lab Practical (No Coding): 
1. Lab 1 - Exploring Public Datasets (Orange Data Mining) 

• Visit a public repository (Kaggle, UCI, data.gov.in) 

• Download a dataset (e.g., rainfall data, literacy rates, or traffic accident statistics) 

• Procedure: 

1. Open Orange → Add File widget → Load a CSV (e.g., Titanic dataset). 

2. Connect to Data Table → View rows/columns. 

3. Connect to Data Info → Check attributes, data types. 

4. View in Data Table and Distributions widget. 

• Observation: Note numeric, categorical, missing values. 

• Outcome: Students understand structured data format in CSV. 

2. Lab 2 – Exploring Cybersecurity Datasets (Orange Data Mining) 

• Dataset: Kaggle Cybersecurity dataset.  
https://www.kaggle.com/datasets/teamincribo/cyber-security-attacks?select=cybersecurity_attacks.csv 

• Procedure: 

1. Load dataset into Orange (File widget). 

2. View using Data Table and Distributions widgets. 

3. Identify numerical (packet size, duration) and categorical (protocol type, 

attack type) attributes. 

• Observation: Note features that indicate “attack” vs. “normal traffic.” 

• Outcome: Students understand the type of features used in intrusion detection. 

3. Lab 3 - Understanding Dataset Metadata and Formats 

• Take two datasets in different formats (CSV, JSON) 

• View metadata (description, features, size, license) 

• Compare domain-specific datasets (e.g., medical vs. finance) 

4. Lab 4 - Data Annotation Exercise 

• Use MakeSense.ai or VGG Image Annotator (VIA) 

• Annotate 10 sample images (traffic signs, fruits, or medical scans) 

• Export annotations in XML or YOLO format 

• Discuss annotation errors and challenges 

5. Lab 5 - Data Cleaning and Visualization (Orange Data Mining) 

• Aim: To clean dirty data and visualize categorical and numeric attributes. 

• Procedure: 

https://www.kaggle.com/datasets/teamincribo/cyber-security-
https://www.kaggle.com/datasets/teamincribo/cyber-security-attacks?select=cybersecurity_attacks.csv
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1. Load dataset. 

2. Connect File → Edit Domain (to change types) and Impute (to fill missing values). 

3. Compare cleaned vs. original in Data Table. 

4. Distributions widget. 

5. Check various features distribution. 
(Optional: Create simple bar charts/line charts to visualize trends using Google Looker Studio) 

• Observation: Missing values filled with mean/median, Graphical representation of 

data. 

• Outcome: Learn importance of data cleaning., Students learn importance of 

visualization in preprocessing. 

6. Lab 6: Train/Test Split in Orange 

• Aim: To split dataset for AI training/testing. 

• Procedure: 

1. Load Titanic dataset. 

2. Connect File → Data Sampler (70% train, 30% test). 

3. Connect outputs to Data Table widgets to view. 

• Observation: Students see two different subsets. 

• Outcome: Concept of model validation using split data. 

7. Lab 7 – Writing a Detailed Prompt for a Simple Game App (Generative AI) 

• Objective: Understand prompt engineering by designing a game idea. 

• Activity: 

1. Open ChatGPT (or Gemini, Copilot). 

2. Write a detailed prompt like “Create a simple text-based treasure hunt game 

with levels, scoring, and random challenges.” 

3. Ask the AI to refine game rules, scoring, and characters. 

4. Document how prompt detail changes the AI’s response. 

• Outcome: Students learn how detailed prompts shape AI outputs. 

8. Lab 8 – Create a Portfolio Website using Vibe Coding Tool 

• Objective: Learn how AI-assisted coding tools can automatically generate websites 

from simple instructions. 

• Activity: 

1. Open Vibe Coding Tool (Windsurf/Cursor/Firebase Studio/Any other vibe 

coding tool). 

2. Give a natural language instruction: 

3. “Create a personal portfolio website for a Computer Science student. It should 

have sections: About Me, Education, Skills, Projects, and Contact.” 

4. Experiment with different prompts to change layout, theme, or color scheme 

5. (e.g., “Make it a modern dark theme with blue highlights.”). 

6. Preview the generated site and customize content. 

• Outcome: Students experience how AI converts prompt into functional websites 

with minimal coding effort. 

9. Lab 9 – Develop an Interactive Education Quiz App using Vibe Coding Tool 
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• Objective: Understand AI’s role in creating educational applications. 

• Activity: 

1. Open Vibe Coding Tool. 

2. Give prompt: 

“Build an interactive quiz app for students with multiple-choice questions on 

AI basics. Include features: Start Quiz, Show Score, Retry.” 

3. Refine the app by asking AI to: 

▪ Add timer for each question. 

▪ Show correct/incorrect answers instantly. 

▪ Add a Leaderboard page. 

4. Test the app by playing the quiz. 

• Outcome: Students see how AI-generated apps can support e-learning and 

assessments. 

10. Lab 10 – Automating Feedback Summarization using n8n and AI 

• Objective: Automatically summarize student feedback responses using AI and 

email the summary to the teacher. 

• Steps: 

1. Trigger Node: Google Sheets (watch new row for feedback). 

2. AI Node: Send text to OpenAI/Gemini API for summarization. 

(Get a free API from OpenRouter (https://openrouter.ai/) → Gives free trial 

credits + access to multiple models.) 

3. Action Node: Gmail → email summarized feedback to teacher. 

4. Test: Enter sample feedback in Google Sheet → receive AI summary via email. 

5. Discussion: How AI reduced manual effort in reading every response. 

• Outcome: Students see how automation + AI can transform data into insights 

instantly. 

11. Lab 11 – Using AI Functions in Google Sheets 

• Objective: Enable students to experience Google Sheets’ built-in AI-powered 

features like summarizing, categorizing, sentiment analysis, and text generation 

through simple prompts within the spreadsheet environment. 

• Tools & Setup 

- Enable Google Sheets with Workspace Labs https://workspace.google.com/labs-

sign-up/u/1/ 

- Follow the References and experiment with summarizing, categorizing, sentiment 

analysis, and text generation using =AI() function 

- https://support.google.com/docs/answer/15820999?visit_id=6389198190146

25788-1742465261&p=ai-function&rd=1 
- https://support.google.com/docs/answer/13447609?hl=en&sjid=9077695331310534831-NC 

- https://support.google.com/docs/answer/13635180?hl=en&ref_topic=134500

85&sjid=9077695331310534831-NC 

• Outcome: Students will experience various AI functions within a spreadsheet-text 

generation, summarization, categorization, sentiment analysis. 

 

https://workspace.google.com/labs-sign-up/u/1/
https://workspace.google.com/labs-sign-up/u/1/
https://support.google.com/docs/answer/15820999?visit_id=638919819014625788-1742465261&p=ai-function&rd=1
https://support.google.com/docs/answer/15820999?visit_id=638919819014625788-1742465261&p=ai-function&rd=1
https://support.google.com/docs/answer/15820999?visit_id=638919819014625788-1742465261&p=ai-function&rd=1
https://support.google.com/docs/answer/13447609?hl=en&sjid=9077695331310534831-NC
https://support.google.com/docs/answer/13635180?hl=en&ref_topic=13450085&sjid=90776953
https://support.google.com/docs/answer/13635180?hl=en&ref_topic=13450085&sjid=90776953
https://support.google.com/docs/answer/13635180?hl=en&ref_topic=13450085&sjid=9077695331310534831-NC
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12. Lab 12 – Deep Fake Image Detection  

• Objective 

Enable students to critically assess image authenticity using multiple free AI tools, 

understanding the strengths and limitations of each. 

• Tools: 

- Deepfake-O-Meter: 

- https://zinc.cse.buffalo.edu/ubmdfl/deep-o-meter/landing_page 

- Decopy AI Image Detector: https://decopy.ai/ai-image-detector/ 

• Procedure 

1. Collect Images 

- 2 real images (e.g., faces from Unsplash or personal photos) 

- 2 AI-generated or manipulated images (e.g., from Midjourney, DALL·E, or 

Google AI studio) 

2. Run through DeepFake-o-Meter 

- Visit the platform and upload an image. 

- Note the output: what algorithms flag or overall score for authenticity. 

3. Use Decopy AI Image Detector 

- Upload the same images. 

- Check results indicating whether the image appears AI-generated. 

• Observation: How AI tools help in Digital Forensics. 

 

 

Note: The Tools suggested above are tentative. Teacher/Student is free to choose any 

other similar tool to execute the said lab experiments. 

*******@@@****** 

 

  

https://zinc.cse.buffalo.edu/ubmdfl/deep-o-meter/landing_page
https://decopy.ai/ai-image-detector/
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

Justification Report on Modification of Programme: B.Sc. (Honours) in Computer Science 

(with effect from Academic Year 2025-26) 
 

Paper – 1: Computer Fundamentals and Office Automation 
S. No Title Topic Added/Deleted Justification 

1 
Unit–IV: Spread 

Sheet Basics 

Deleted: VLOOKUP, HLOOKUP, 

INDEX, MATCH 

These are deprecated ones, 

new version XLOOKUP is 

there. 

2 

Unit–V: Data 

Analysis and 

Visualization 

Deleted: Charts and Dashboards: 

Creating Interactive Dashboards, 

Using slicers with Pivot Tables, 

Combo Charts and Sparklines 

In view of vastness. 

 

Paper – 2: Problem Solving Using C 
S. No Title Topic Added/Deleted Justification 

1 

Unit–

IV: Functions, 

Pointers  

Deleted: pointer arithmetic 

This is confusion topic while 

teaching, new programming 

languages does not support.  

2 

Unit–

V: Structures, 

Unions, Files 

Deleted: structure and functions, 

structures and pointers 

This is a very vast area and has 

ambiguity while teaching and 

paper setting.  
 

Paper – 3: Data Structures Using C 
S. No Title Topic Added/Deleted Justification 

1 
Unit–I: Basic 

Concepts  

Added: Array Operations 

 

 

Deleted: Asymptotic Notations 

Needed to understand 

operations on other data 

structure. 

Not needed here, this topic is 

also covered in Algorithms. 

2 
Unit–V: Trees, 

Graphs 

Deleted: Concept of Shortest 

Path Problems, Concept of 

Minimum Cost Spanning Tree 

In view of vastness and this 

topic is covered in Algorithms. 

 

Paper – 4: Digital Logic Design 
S. No Title Topic Added/Deleted Justification 

1 

Unit–V:  

Sequential 

Circuits  

Deleted: design of ripple counters, 

modulus counters 
In view of vastness. 
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

 

Justification Report on Modification of Programme: B.A/B.COM/B.Sc. (Honours)  

(with effect from Academic Year 2025-26) 

 

SEC – 1: Introduction to Artificial Intelligence 

S. No Title Topic Added/Deleted Justification 

1  No changes, same as per APSCHE syllabus  

 

SEC – 2: Applications of Artificial Intelligence 

S. No Title Topic Added/Deleted Justification 

1  No changes, same as per APSCHE syllabus  
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

I BSc (Honours) Computer Science 

INTERNAL EXAMINATION 
Paper – 2:  Problem Solving Using C 

QUESTION PAPER PATTERN 

Time: 1 Hour                                                                                                              Max. Marks: 20 

SECTION – A 

(Short Answer Questions) 

Answer any TWO of the following questions                                          Marks: 2 x 5 m = 10 

1. 

2. 

3. 

4. 

SECTION – B 

(Essay Answer Questions) 

Answer any ONE of the following questions                                          Marks: 1 x 10 m = 10 

1. 

2. 

 

 

CONTINUOUS INTERNAL ASSESSMENT (CIA)- 10M 
1. Assignment – 5 Marks 

2. Seminar & Viva Voce – 5 Marks 

 

Total Internal Marks : 20 Marks + 10 Marks = 30 Marks 

 

*******@@@****** 
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

I BSc (Honours) Computer Science 

SEMESTER END EXAMINATION 
Paper – 2:  Problem Solving Using C 

QUESTION PAPER PATTERN 

Time: 3 Hours                                                                                                              Max. Marks: 70 

SECTION – A 

(Short Answer Questions) 

Answer any FIVE of the following questions                                          Marks: 5 x 4 m = 20 

1. 

2. 

3. 

4. 

5. 

6. 

7. 

8. 

SECTION – B 

(Essay Answer Questions) 

Answer any ALL of the following questions                                          Marks: 5 x 10 m = 50 

9.    a)  

OR 

       b) 

10. a)  

OR 

       b) 

11. a)  

OR 

       b) 

12. a)  

OR 

       b) 

13. a)  

OR 

      b) 

*******@@@****** 
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MODEL PAPER  

I BSc (Honours) Computer Science 
SEMESTER – I END EXAMINATION 

COURSE – 1:  COMPUTER FUNDAMENTALS AND OFFICE AUTOMATION 
Time: 3 Hours                                                                                                              Max. Marks: 70 

SECTION – A 

(Short Answer Questions) 

Answer any FIVE of the following questions                                          Marks: 5 x 4 m = 20 

1. Write about evolution of computers. 
2. Write the characteristics of different generations of computers. 
3. Discuss memory hierarchy in computer systems. 
4. Briefly write about types of computers. 
5. Explain any five keyboard shortcuts. 
6. How do we format the text in MS Word? Explain. 
7. Explain conditional formatting in MS Excel with example. 
8. What are the uses of lookup function in MS Excel?  

SECTION – B 

(Essay Answer Questions) 

Answer any ALL of the following questions                                          Marks: 5 x 10 m = 50 

9.    a) Explain conversion between number systems with examples. 

OR 

       b) Draw block diagram of computer and explain functions of various components. 

10. a) Explain different types of networks with diagrams. 

OR 

       b) Discuss about IP Address, WWW and Email. 

11. a) Explain the use of mail merge with suitable example. 

OR 

       b) Explain the creation of presentation with suitable example. 

12. a) Describe the use of functions with any five examples. 

OR 

       b) Explain the creation of visual representation with examples in MS Excel. 

13. a) Describe the pivot tables and pivot charts uses with examples. 

OR 

      b) Explain the data validation options with suitable examples. 

*******@@@****** 
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MODEL PAPER  

I BSc (Honours) Computer Science 
SEMESTER – I END EXAMINATION 

COURSE – 2:  PROBLEM SOLVING USING C 
Time: 3 Hours                                                                                                              Max. Marks: 70 

SECTION – A 

(Short Answer Questions) 

Answer any FIVE of the following questions                                          Marks: 5 x 4 m = 20 

1. Define flowchart? Briefly explain the flowchart symbols. 
2. Discuss about data types. 
3. Explain the if-else statement in C. 
4. Illustrate the purpose of break statement with an example. 
5. Describe the declaration and initialization of 1D arrays. Provide an example. 
6. Define string? Explain declaration and initialization in C. 
7. Explain the pointer arithmetic in C. 
8. Differentiate structures and unions 

SECTION – B 

(Essay Answer Questions) 

Answer any ALL of the following questions                                          Marks: 5 x 10 m = 50 

9.    a) Explain the structure of the C program with example. 

OR 

       b) Explain Operators in C with suitable example. 

10. a) Illustrate decision-making statements in C. 

OR 

       b) Discuss iterative statements in C. 

11. a) Explain the memory representation of 1D arrays and 2D arrays. How to read and  

             access the elements of 1D and 2D arrays? Illustrate with examples. 

OR 

       b) Explain the string handling functions in C. 

12. a) Discuss in detail the parameter passing mechanism in C. Give necessary examples. 

OR 

       b) Discuss the storage classes in C with example. 

13. a) Describe the dynamic memory allocation functions in C. 

OR 

      b) Describe the concept of structures explain the declaration, initialization and  

            accessing the element of structures with example. 

*******@@@****** 
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MODEL PAPER  

I BSc (Honours) Computer Science 
SEMESTER – I END EXAMINATION 

COURSE – 3: DATA STRUCTURES USING C 
Time: 3 Hours                                                                                                              Max. Marks: 70 

SECTION – A 

(Short Answer Questions) 

Answer any FIVE of the following questions                                          Marks: 5 x 4 m = 20 

1. Define algorithm. Write the characteristics of an algorithm.  

2. What is an array? Explain with example. 

3. What is double linked list? Explain with example. 

4. Differences between linked list and array. 

5. What are the applications of stacks? 

6. What is recursion? Explain with an example. 

7. Explain sequential search with an example. 

8. What are the applications of graphs. 
SECTION – B 

(Essay Answer Questions) 

Answer any ALL of the following questions                                          Marks: 5 x 10 m = 50 

9.    a) What is DS? Differences between ADT and primitive DT. 

OR 

       b) What are the operations on array? Explain with examples. 

10. a) Explain all operations on single linked list with examples. 

OR 

       b) Discuss different types of linked lists. 

11. a) Explain stack ADT with all possible operations. 

OR 

       b) Explain queue ADT with all possible operations. 

12. a) Write about binary search algorithm with example. 

OR 

       b) Explain merge and bubble sort algorithms with examples. 

13. a) What is binary search tree? Explain all possible operations on binary search tree. 

OR 

      b) What is graph? Explain DFS and BFS traversal algorithms. 

*******@@@****** 
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MODEL PAPER  

I BSc (Honours) Computer Science 
SEMESTER – I END EXAMINATION 

COURSE – 4:  DIGITAL LOGIC DISGN 
Time: 3 Hours                                                                                                              Max. Marks: 70 

SECTION – A 

(Short Answer Questions) 

Answer any FIVE of the following questions                                          Marks: 5 x 4 m = 20 

1. Describe the representation of floating-point numbers using an example. 

2. Convert the hexadecimal number 19A to its equivalent decimal and octal 

representations. 

3. Explain the concept of universal gates with truth tables and diagrams in digital logic 

design. 

4. Discuss the significance of don’t care conditions in the simplification of logic functions 

with examples. 

5. Discuss the Half adder in combinational logic circuit. 

6. What is a multiplexer and how does the select input of a multiplexer contribute to its 

operation? 

7. Define a flip–flop and provide the characteristic equation for an S–R flip–flop. 

8. Describe the operation of a bidirectional shift register? 
SECTION – B 

(Essay Answer Questions) 

Answer any ALL of the following questions                                          Marks: 5 x 10 m = 50 

9.    a) Explain the various number systems used in digital systems. 

OR 

       b) Explain the addition and subtraction of signed and unsigned binary numbers. 

10. a) Discuss in detail about logic gates. Provide their truth tables. 

OR 

       b) Using K-Map find the Boolean function and its complement for the following  

             F(A, B, C, D) = ∑(1,2,3,4,6,8,9,10,11,12,14). 

11. a) Define a combinational logic circuit and demonstrate its application by  

             constructing a Full Adder using two Half adders and one OR gate. 

OR 

       b) Explain ripple adders and subtractors in details. Provide necessary examples. 

12. a) Explain Multiplexers and De–Multiplexers with examples. 

OR 

       b) Discuss the encoders and decoders in combination logic. 

13. a) Explain the JK and D Flip–Flops. 

OR 

      b) Explain the shift registers in detail. 

*******@@@****** 
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

I BA/BCOM/BSc (Honours)  

INTERNAL EXAMINATION 
SEC– 1:  Introduction to Artificial Intelligence 

QUESTION PAPER PATTERN 

Time: 1 Hour                                                                                                              Max. Marks: 20 

SECTION – A 

(Short Answer Questions) 

Answer any TWO of the following questions                                          Marks: 2 x 5 m = 10 

1. 

2. 

3. 

4. 

SECTION – B 

(Essay Answer Questions) 

Answer any ONE of the following questions                                          Marks: 1 x 10 m = 10 

1. 

2. 

 

 

CONTINUOUS INTERNAL ASSESSMENT (CIA)- 10M 
1. Assignment – 5 Marks 

2. Seminar & Viva Voce – 5 Marks 

 

Total Internal Marks : 20 Marks + 10 Marks = 30 Marks 

 

*******@@@****** 
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE  

I BA/BCOM/BSc (Honours)  

SEMESTER END EXAMINATION 
SEC – 1:  Introduction to Artificial Intelligence 

QUESTION PAPER PATTERN 

Time: 3 Hours                                                                                                              Max. Marks: 70 

SECTION – A 

(Short Answer Questions) 

Answer any FIVE of the following questions                                          Marks: 5 x 4 m = 20 

1. 

2. 

3. 

4. 

5. 

6. 

7. 

8. 

SECTION – B 

(Essay Answer Questions) 

Answer any ALL of the following questions                                          Marks: 5 x 10 m = 50 

9.    a)  

OR 

       b) 

10. a)  

OR 

       b) 

11. a)  

OR 

       b) 

12. a)  

OR 

       b) 

13. a)  

OR 

      b) 

*******@@@****** 
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MODEL PAPER  

I BA/BCOM/BSc (Honours) COMMON PAPER 
SEMESTER – I END EXAMINATION 

SEC – 1:  INTRODUCTION TO ARTIFICIAL INTELLIGENCE 
Time: 3 Hours                                                                                                              Max. Marks: 70 

SECTION – A 

(Short Answer Questions) 

Answer any FIVE of the following questions                                          Marks: 5 x 4 m = 20 

1. Define AI. What are AI subfields? 
2. Define Artificial General Intelligence. 
3. What are the challenges in AI? 
4. What is mean bias in AI systems? Explain. 
5. What is mean fairness in AI systems? Discuss. 
6. Write about Generative AI. 
7. Discuss any one Generative AI tool. 
8. How do we generate slides using AI? Explain. 

SECTION – B 

(Essay Answer Questions) 

Answer any ALL of the following questions                                          Marks: 5 x 10 m = 50 

9.    a) Discuss the industry applications of AI. 

OR 

       b) Briefly write about Machine Learning, Computer Vision, Robotics. 

10. a) Discuss the applications of AI in Educations and Transportations. 

OR 

       b) Discuss the applications of AI in Healthcare and Retail Market. 

11. a) Discuss the Accountability, Transparency and Ethics in AI Systems. 

OR 

       b) Discuss the security and privacy issues in AI systems. 

12. a) Describe any two Generative AI tools. 

OR 

       b) Explain the role and important of prompt engineering in AI. 

13. a) Explain the applications of prompt engineering in content creations. 

OR 

      b) Explain the use of AI in creative design. 

*******@@@****** 
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CLUSTER UNIVERSITY : KURNOOL 
DEPARTMENT OF COMPUTER SCIENCE 

Panel of Paper Setters and Examiners approved 

in Board of Studies Meeting held on 29.11.2025 

S. No Name, Designation and  Address Mobile Number 

1 

Dr G. V. Ramesh Babu 

Professor in Computer Science 
S. V. University, Tirupati. 

9246999922 

2 

Dr B. Kavitha 

Lecturer in Computer Science 
S.V.A Govt. College, Srikalahasti, Chittoor. 

9989350887 

3 
Sri P. Rajendar 

Lecturer in Computer Science, GDC Nandyal. 
8814328908 

4 
Dr. N. Uday Bhaskar 

Lecturer in Computer Science, GDC Anantapur 
9885238374 

5 

Sri. M. Ismail 

Lecturer in Computer Science 
GDC, Veduru Kuppam. 

8555982073 

6 
Sri P. Pothuraju 

Lecturer in Computer Science, GDC Nandyal. 
9966369484 

7 
Smt. Haritha 

Lecturer in Computer Science, GDC(W), Kadapa. 
9652010013 

8 
Dr. C. V. KrishnaVeni 

Lecturer in Computer Science, GDC(W), Kadapa. 
9490519982 

9 
Sri Y. Raghavendra 

Lecturer in Computer Science, GDC, Anantapur. 
9848375300 

10 
Sri G. Dayanandam 

Lecturer in Computer Science, GDC Railway Koduru 

9885553539 
 

11 

Sri Manoj PrabakarDarsi 

Lecturer in Computer Science 
DKW Govrt. College , Nellore. 

9492441242 

12 

Sri Y. Srinivasulu 

Lecturer in Computer Applications 
GDC Veduru Kuppam.  

9985883900 

13 
Smt. Madhavi 

Lecturer in Computer Applications, GDC Anantapur 
9949672448 

 


